
 File menu commands

The File menu offers the following commands:

New Creates a new chart.
Open Opens an existing chart.
Close Closes an opened chart.
Save Saves an opened chart using the same file name.
Save As Saves an opened chart to a specified file name.
Print Prints the Current View of the active chart.
Print 
Preview

Displays the Current View of the active chart as it would appear when 
printed.

Print Setup Selects a printer and printer connection.
Preferences Change TreeChart program preferences.
1,2,3,4 Opens one of four most recently used files.
Exit Exits TreeChart.



 Window menu commands

The Window menu offers the following commands to enable you to arrange and switch 
between different chart windows in the TreeChart application window:

Cascade Arranges windows so that they overlap.
Tile Horizontal Arranges chart windows side by side.
Tile Vertical Arranges windows stacked vertically.
Arrange Icons Arranges icons of minimized chart windows.
Window 1, 
2, ...

Goes to specified chart window.



 New command (File menu)

Use this command to create a new chart in TreeChart.

If you have specified a Template File, the Template File is loaded to serve as the initial 
settings for your new chart.

You can open multiple charts at once. Use commands on the Window menu to switch among 
the multiple open charts and arrange chart windows.

You can open an existing chart with the Open command.

Shortcuts
Toolbar:

Keys: CTRL+N

See Also
Open command
Speeding up your work with Template Files
Window menu



 Open command (File menu)

Use this command to open an existing chart in a new window.

You can open multiple charts at once. Use commands on the Window menu to switch among 
the multiple open charts and arrange chart windows.

You can quickly open one of the four most recently used charts by choosing the filenames 
listed near the bottom of the File menu.

You can create new charts with the New command.

Shortcuts
Toolbar:

Keys: CTRL+O

See Also
File Open dialog box
1,2,3,4 command
New command
Window menu



 File Open dialog box

The following options allow you to specify which file to open:

File Name Type or select the filename you want to open. This box lists files with 
the extension you select in the List Files of Type box. 

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

List Files of Type This controls both the file types listed in the File Name list control, and 
the format that TreeChart expects to read.

Select the type of file you want to open:

TreeChart Files (*.TCF) List: All files of type .TCF
Open: TreeChart-format file.

This is the normal format for TreeChart use, since it retains all chart information.

Template Files (*.TCT) List: All files of type .TCT
Open: TreeChart-format Template file.

TreeChart-format files to be used as Templates normally have the filename 
extension .TCT to indicate they serve a different purpose.

Text Files (*.TXT) List: All files of type .TXT
Open: Windows-format text file.

Unformatted text as saved by another program.

All Files (*.*) List: All files
Open: TreeChart-format file.

Drives Select the drive in which TreeChart stores the file that you want to 
open. 

Directories Select the directory in which TreeChart stores the file that you want to 
open.

Network... Choose this button to connect to a network location, assigning it a new 
drive letter. 

See Also
Speeding up your work with Template Files
Keys for working with dialog boxes



 Close command (File menu)

Use this command to close the active chart.

If the chart has been changed since you last saved it, TreeChart prompts you to save the 
chart. If you close a chart without saving, you lose all changes made since the last time you 
saved it.

Shortcuts
Mouse: Double-click the chart's Control menu button.

Keys: CTRL+F4



 Save command (File menu)

Use this command to save the active chart to its current name and directory.

When you save a chart for the first time, TreeChart prompts you for a file name and 
directory.

If you want to change the name and directory of an existing chart before you save it, choose
the Save As command.

Shortcuts
Toolbar:

Keys: CTRL+S

See Also
Save As command
Save As dialog box



 Save As command (File menu)

Use this command to save and name the active chart.

TreeChart prompts you for a file name and directory.

To save a chart with its existing name and directory, use the Save command.

See Also
Save command
Save As dialog box



 File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:

File Name Type a new filename to save a chart with a different name. A filename 
can contain up to eight characters and an extension of up to three 
characters. 

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

Save File as Type This controls both the file types listed in the File Name list control, and 
the format in which TreeChart saves the chart.

Select the format in which the chart should be saved:

TreeChart File (.TCF) A TreeChart-format file.
Use this format to retain all chart information. This is 
the normal format for TreeChart use.

Template File (*.TCT) A TreeChart-format Template file.
TreeChart-format files to be used as Templates 
normally have the filename extension .TCT to 
indicate they serve a different purpose.

Text & Commas (.TXT) A Windows-format data file.
Suitable for use with a word processor or 
spreadsheet. Contains only Box text; no Layout or 
hierarchy information.

Text & Tabs (.TXT) A Windows-format data file.
Suitable for use with a word processor or 
spreadsheet. Contains only Box text; no Layout or 
hierarchy information.

Outline Text (.TXT) A Windows-format data file.
Similar to Text & Tabs, but containing Text Field 
names & Box hierarchy information, plus the name of
a Layout (but not its settings).

Windows Metafile (.WMF) A picture of the 
Current View of the chart, similar to as it 
would be printed.

Drives Select the drive in which you want to store the chart. 

Directories Select the directory in which you want to store the chart.

Network... Choose this button to connect to a network location, assigning it a new 
drive letter. 

See Also
Speeding up your work with Template Files
Keys for working with dialog boxes





 1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
charts you closed. Choose the number that corresponds with the chart you want to open.



 Exit command (File menu)

Use this command to end your TreeChart session.

You can also use the Close command on the application Control menu.

TreeChart prompts you to save charts with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



 Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most commonly used commands in TreeChart.

A check mark appears next to the menu item when the Toolbar is displayed.

Shortcuts
Keys: SHIFT+F2

See Also
Toolbar



 Toolbar

The Toolbar is displayed across the top of the application window, below the menu bar. The 
Toolbar provides quick mouse access to many commands used in TreeChart,

To hide or display the Toolbar, choose Toolbar from the View menu, or press SHIFT+F2.

In addition to the command buttons listed below, the Toolbar also enables the zoom factor of
the current chart window to be altered, by means of a drop-down list.

Click To

Create a New chart.

Open an existing chart.

Save the active chart or template with its current name.

Cut selected boxes from the chart and stores them on the clipboard.

Copy selected boxes to the clipboard.

Paste Below (insert) the contents of the clipboard below the Current Box.

Select all boxes.

Select Sub-Tree - Select the Current Box    and all boxes below it.

Select Level - Select all boxes at the level of the Current Box.

Select Subordinates - Select all boxes immediately below the Current Box.

Mark Boxes as exceptions to the rules.

Text Styles - Change the text style of any fields within any Layouts.

Define Layouts - Create, rename, edit, change use of a Layout.

View All boxes, by removing Focus and expanding all collapsed boxes.



Focus on the Current Box and all boxes below it; hide boxes on other branches.

Collapse selected boxes, hiding all boxes below them.

Expand selected boxes, revealing all boxes below them.

Expand all collapsed boxes.

Print the Current View of the active chart.

Preview printing.

Enter context-sensitive Help mode.

See Also
Zooming the Chart display
Outlining
Keys to access Toolbar buttons



 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state.

A check mark appears next to the menu item when the Status Bar is displayed.

Shortcuts
Keys: CTRL+F2

See Also
Status Bar



 Status Bar

The Status Bar is displayed at the bottom of the TreeChart window.

To display or hide the status bar, use the Status Bar command in the View menu, or press 
CTRL+F2.

The left area of the Status Bar describes actions of menu items as you use the arrow keys to 
navigate through menus. This area similarly shows messages that describe the actions of 
Toolbar buttons as you press them. If after viewing the description of the Toolbar button 
command you wish not to execute the command, then release the mouse button while the 
pointer is off the Toolbar button.

The left area of the status bar also advises when some longer duration actions are in 
progress, such as opening or saving files.

The right areas of the status bar indicates chart and keyboard status:

Indicator Description
Total Levels The number of levels in the active chart.
Current Level The level of the Current Box in the active chart.
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
Total boxes The number of boxes in the active chart.
Hidden boxes The number of boxes in the active chart hidden using outlining. If this 

indicator is not blank, the Current View is not the whole chart.
Some of the Status Bar fields reflect the conditions in the active chart. If you switch to a 
different
chart, the information is updated to reflect the conditions in the activated chart.

See Also
Toolbar
Outlining



 Tile Horizontal (Window menu)

Moves and resizes all open chart windows, then arranges them side-by-side so they are all 
visible and none of them overlap.



 Cascade command (Window menu)

Moves and resizes all open chart windows, then arranges them in an overlapped fashion.



 Tile Vertical command (Window menu)

Moves and resizes all open chart windows, then arranges them stacked vertically so they are
all visible and none of them overlap.



 Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.

If there is an open chart window at the bottom of the main window, then some or all of the 
icons may not be visible because they will be underneath this chart window.



 1, 2, ... command (Window menu)

TreeChart displays a list of currently open chart windows at the bottom of the Window menu.
A check mark appears in front of the chart name of the active window. Choose a chart from 
this list to make its window active.    



 Contents command (Help menu)

Use this command to display the opening screen of TreeChart's on-line Help.

From the opening screen, you can jump to step-by-step instructions for using TreeChart and 
various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.

Shortcuts
Keys: CTRL+F1

See Also
Getting Help in TreeChart



 Using Help command (Help menu)

Use this command for instructions about using Help.

See Also
Getting Help in TreeChart



 Search For Help command (Help menu)

Use this command to search TreeChart's on-line Help for particular keywords.

The Search dialog box is displayed:

1 Type a keyword, or select one from the list of recognized keywords.

2 Choose Show Topics (or double-click on the keyword list) to show a list of topics with 
the selected keyword.

3 Select a topic from the list and choose Go To (or double-click the topic list) to go to 
the selected Help topic.

Once you open Help, you can click the Search button whenever you want to search the on-
line Help by keyword.

See Also
Getting Help in TreeChart
Keys for working with dialog boxes



 About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
TreeChart.



 Help Mode command

Use the Help mode command to obtain help on some portion of TreeChart.

When you choose this command, the cursor changes to 

Then click somewhere in the TreeChart window, such as a Toolbar button or a menu item.

The Help topic will be shown for the item you clicked.

Pressing ESC while the Help Mode cursor is displayed returns you to normal working without 
getting Help.

Shortcut
Toolbar:

Keys: SHIFT+F1

See Also
Getting Help in TreeChart



 Title Bar

The title bar is located along the top of a window. It contains the names of the application 
and the active chart.

To enlarge a window to full size, double-click on the title bar.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Chart Control-menu button
Maximize button
Minimize button
Name of the application
Name of the active chart
Restore button

See Also
Keys for managing the TreeChart application window
Keys for managing chart windows



 Scroll bars

Displayed at the right and bottom edges of the chart window. The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the chart. You can use the mouse 
to scroll to other parts of the chart.

See Also
Keys for scrolling a chart window



 Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:

1 Press one of the ARROW keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move.

2 Press an ARROW key to move the border.

3 Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



 Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the title bar.



 Minimize command (application Control menu)

Use this command to reduce the TreeChart window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.



 Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



 Next Window command (chart Control menu)

Use this command to switch to the next open chart window.

TreeChart determines which window is next according to the order in which you opened the 
windows.

Shortcut
Keys: CTRL+F6



 Previous Window command (chart Control menu)

Use this command to switch to the previous open chart window.

TreeChart determines which window is previous according to the order in which you opened 
the windows.

Shortcut
Keys: SHIFT+CTRL+F6



 Close command (Control menus)

Use this command to close the active window or dialog box.

Shortcuts
Mouse: Double-click the window's Control menu button.

Keys: CTRL+F4 closes a chart window
ALT+F4 closes the TreeChart window or a dialog box



 Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



 Switch to command (application Control menu)

Use this command to display a list of all open applications.

Use this "Task List" to switch to or close an application on the list:

Task List Select the application you want to switch to or close.

Switch To Makes the selected application active.

End Task Closes the selected application.

Cancel Closes the Task List box.

Cascade Arranges open applications so they overlap and you can see each title 
bar. This option does not affect applications reduced to icons.

Tile Arranges open applications into windows that do not overlap. This 
option does not affect applications reduced to icons.

Arrange Icons Arranges the icons of all minimized applications across the bottom of 
the screen.

Shortcut
Keys: CTRL+ESC

See Also
Keys for working with dialog boxes



 Choose Font dialog box

The following options allow you to specify a font and its style:

Font Select from the list of available fonts. TreeChart lists only those fonts 
that are available on the current printer and for screen use.

Style Select the font style. Options listed depend on the selected Font, but 
normally include options such as Regular, Bold and Italic.

Size Select the point size you require.

Strikeout Select this checkbox to enable text strikeout.

Underline Select this checkbox to enable text underlining.

Color Select a color for the text.

See Also
Keys for working with dialog boxes



 Choose Color dialog box:

Box Fill Color
Box Border Color
Box Shadow Color
Connections Line Color
Background Color
Border Color
Border Shadow Color

This dialog allows you to choose a color. It is initially presented as a simple color-picker, 
offering up to 48 preset colors chips and 16 custom colors chips. You can expand the dialog 
to define a color different to the displayed preset and custom colors, or to change the 
custom colors.

The actual number of preset colors displayed is determined by the display driver. For 
example, a VGA driver displays 48 colors, and a monochrome display driver displays only 16.

TreeChart allows you to store 16 custom colors with each chart. These all default to white 
unless you define different colors in a Template File.

If the color you are changing matches one of the preset or custom colors, that color chip will 
be selected initially.

To select an existing color:

Click on the color chip, then click on OK.

To modify a custom color:

Click on the custom color chip, then choose the Define Custom Colors button. The dialog is 
expanded to enable you to define a new color. Change the color (see below), then choose 
the Add to Custom Colors button to update the custom color chip.

To define a custom color:

Click on Define Custom Colors. The dialog is expanded to enable you to define a new color.

Specify red, green, and blue (RGB) values by using the Red, Green, and Blue edit controls.

or

Specify hue, saturation, and luminosity (HSL) values by using the Hue, Sat, and Lum edit 
controls.

or

Click on the color spectrum control (at the upper-right of the dialog box) to select hue and 
saturation values; click on the luminosity control (the rectangle to the right of the spectrum 
control). This method is only available if you have a mouse.

Whichever technique you use...

The Color|Solid control displays the dithered and solid colors that correspond to your 



selection. (A dithered color is a color created by combining one or more pure or solid colors.)
Note that most Windows devices are unable to use dithered colors to draw lines. Generally 
speaking, therefore, color use is:

Box Fill Color Dithered
Box Border Color Solid
Box Shadow Color Dithered
Connections Line Color Solid
Background Color Dithered
Border Color Solid
Border Shadow Color Dithered

Selecting OK after defining a color causes that color to be used; selecting Cancel leaves your
chart unchanged (though the custom colors may have been changed). If you wish to add the
newly-defined color to your table of custom colors, you must choose the Add to Custom 
Colors button before selecting OK or Cancel.

Color Models Used by the Choose Color Dialog Box

The Color dialog box uses two models for specifying colors: the RGB model and the HSL 
model. Colors you define are presented in both models, but you'll probably find things 
simpler if you define your colors using the model you feel most comfortable with.

RGB Color Model

The RGB (red, green, blue) model is used to designate colors for displays and other devices 
that emit light. Valid red, green, and blue values are in the range 0 through 255, with 0 
indicating the minimum intensity and 255 indicating the maximum intensity. (With display 
devices, the color black results when the red, green, and blue values are set to 0--that is, 
with display technology, black is the absence of all colors.) 

Following are eight example colors and their associated RGB values: 

Color RGB values

Red 255, 0, 0 
Green 0, 255, 0 
Blue 0, 0, 255 
Cyan 0, 255, 255 
Magenta 255, 0, 255 
Yellow 255, 255, 0 
White 255, 255, 255 
Black 0, 0, 0 

HSL Color Model

The Color dialog box provides controls for specifying HSL (hue, saturation, luminosity) 
values.

To the right of the dialog is a luminosity control. The square color spectrum has saturation on
the vertical axis, and hue on the horizontal axis.

Note that after selecting a white (or near-white) color chip, for instance an unused Custom 
Color, the initial luminosity will be maximum, which would cause the color to be white 
whatever the hue and saturation settings. If you find that changing hue or saturation has no 



effect on the Color|Solid control, you need to adjust the luminosity first.

The saturation and luminosity values are forced to be in the range 0 through 240 and the 
hue value is forced to be in the range 0 through 239.

See Also
Keys for working with dialog boxes



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



 Working in a Chart Window

In a word processor, a document window allows you to manipulate text. In a drawing 
program, a document window allows you to manipulate picture elements (which might 
include lines, rectangles and text).

In a TreeChart chart window, you are manipulating boxes, not lines, rectangles or text. You 
can insert, delete and re-arrange boxes directly, but you can not directly select or change 
the text within boxes, the style of text or boxes, or how connecting lines are routed.

These attributes of boxes are changed by means of dialog boxes, each shown as a result of 
choosing a menu command or pressing a shortcut key. Whenever you change something, 
TreeChart automatically:

Re-calculates how large boxes need to be to contain the text
Re-positions boxes
Re-routes connecting lines

Although re-calculating the chart is automatic, you have a considerable degree of control 
over how the re-calculation is done.

See Also
Boxes and Layouts
Chart Background Color
Inserting Boxes
Keyboard Shortcuts
Moving around a chart
Outlining
Selecting Boxes
Using a mouse in a Chart Window
Zooming the Chart Display



 No Help Available

No help is available for this area of the window.



 No Help Available

No help is available for this message box.



 Preferences command (File menu)

A number of options determining the operation of TreeChart can be specified by the user.

All options can be saved in an initialization file, and restored the next time the program is 
started.

Use this command to change the most commonly used options.

See Also
Preferences dialog box



 Preferences dialog box

A number of options determining the operation of TreeChart can be specified by the user. All 
options can be saved in an initialization file, and restored the next time the program is 
started. Most options can be set by means of this dialog.

Choosing the OK button completes the dialog, and any changes to the preferences will take 
effect from then on.

Choosing the Cancel button completes the dialog with preferences left unchanged.

Choosing the Save button causes the preferences as they appear in the dialog at that 
moment to be stored in the program's initialization file immediately.

Box Insertion What the program does when you insert a new box

Initial Layout
The Layout a box initially uses is either the Default Layout for the level 
at which the box has been inserted or the same Layout as the box it 
was inserted next to.

Prompt for Text
Select this to automatically be prompted for box text.

Default Formats The format used by automatically calculated fields if "(default)" is the 
format selected for the Layout being used.

Date/Time
Default format for Border field <date/time>

Counters
Default format for box fields <number>, <relative number> and 
<level>.

Outline
Default format for box field <outline number>

Clipboard Optional formats copied to the Clipboard

Copy Text
Copy command copies text from the selected boxes

Copy Metafile
Copy command copies metafile picture of Current View plus Border

Template Template file selection

File
Enter Template filename.

Browse
Choose from available Template Files

Miscellaneous Other program preferences 



Center Dialogs
Select to have dialogs shown in the center of the screen

Save Preferences on Exit
Select to have TreeChart preserve preference settings between 
sessions

See Also
Automatically calculated Border fields
Automatically calculated box fields
Exchanging information with other programs
Keys for working with dialog boxes
Speeding up your work with Template Files



 Getting Help in TreeChart

Extensive on-line Help is always available to you when you are working with TreeChart. Help 
is
offered on a context-sensitive basis. This means that the help offered normally depends on 
what you were doing when you requested help.

Command Prompts

The first level of help offered is command prompts. Whenever you highlight a menu item or 
press (but don't release) a Toolbar button, a description of the command is displayed in the 
Status bar prompt field.

Online Help

TreeChart uses the standard Windows Help facility. Once the Help facility has been started, 
you are free to browse amongst topics, search for key words or phrases, add your own 
annotations to topics, or print topics. If you are unsure how to use Help, choose How to Use 
Help from the Help menu in either TreeChart or Help itself, or press F1 when you are in Help.

Help menu

The TreeChart Help menu enables you to start the Help facility with an overall contents 
presented. This can be useful if you are unsure what you need help on.

The Help menu also enables you to search the online Help for particular keywords.

Context-sensitive Help

Pressing F1 requests context-sensitive Help. The topic initially shown depends on what you 
were doing when your pressed F1; if you press F1 while a menu command is highlighted, 
rather than perform the command, help on the command is presented. If you press F1 while 
a dialog or message box is shown, help on that dialog or message box is presented.

Once you have started the Help facility, you are free to browse among topics as normal. 

Help mode

Pressing SHIFT+F1 (or selecting the Help Mode button in the toolbar) stops normal TreeChart 
operation, and allows you to select something you'd like help on.

In this mode the cursor changes to ; just select a menu command or click the left mouse
button over a part of the TreeChart window to select the help topic. If you select a command,
rather than performing the command, help on the command is presented.

Pressing ESC leaves this mode without presenting help.

If you don't have a mouse, you are limited to selecting menu commands.

See Also
Help Contents command
Search for Help command
Help Mode command



Toolbar
Status bar
Keys to Get Help



 Select Template dialog box

The following options allow you to specify which Template File to use when you create a new 
chart or open a text-format file:

File Name Type or select the name of the file you want to use as the Template. 
This box lists files with the extension you select in the List Files of Type 
box. 

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

List Files of Type This controls the file types listed in the File Name list control. You must 
choose a TreeChart-format file as a Template.

Drives Select the drive in which TreeChart stores the file that you want to use 
as the Template. 

Directories Select the directory in which TreeChart stores the file that you want to 
use as the Template.

Network... Choose this button to connect to a network location, assigning it a new 
drive letter. 

See Also
Speeding up your work with Template Files
Keys for working with dialog boxes





 Print command (File menu)

Use this command to print a chart.

This command presents a Print dialog box, where you may specify the range of pages to be 
printed, the number of copies, the destination printer, and other printer setup options.

Note that the Current View (as defined by outlining selections) is printed, rather than the 
whole chart.

Shortcuts

Toolbar:
Keys: CTRL+P

See Also
Outlining
Print dialog box
Printing charts



 Print dialog box

The following options allow you to specify how the chart should be printed:

Printer This is the active printer.

Setup Choose this button to select a different printer or other printer-specific 
options.

Print Range Specify the pages you want to print:
All Prints the Current View of the active chart.
Pages Prints the range of pages you specify in the From and To 

boxes.

Copies Specify the number of copies you want to print for the above page 
range.

Collate Copies Prints copies in page number order, instead of separated multiple 
copies of each page.

Print Quality Select the quality of the printing. Generally, lower quality printing takes
less time to produce.

See Also
Keys for working with dialog boxes
Print Setup dialog box
Printing charts



 Print Progress Dialog

The Printing dialog box is shown during the time that TreeChart is sending output to the 
printer.    
The page number indicates the progress of the printing.

To abandon printing, choose Cancel.



 Print Preview command (File menu)

Use this command to display the Current View of the active chart as it would appear when 
printed.

When you choose this command, the main window will be replaced with a print preview 
window in which one or two pages will be displayed in their printed format.

Shortcuts

Toolbar:

See Also
Print Preview Toolbar
Printing charts



 Print Preview Toolbar

The Print Preview Toolbar offers you the following options:

Print Return from print preview to the main TreeChart window, then show the
Print dialog box to start a print job.

Next Page Preview the next printed page.

Prev Page Preview the previous printed page.

One Page/Two Pages Show one or two pages of preview.

Zoom In See more detail, but less of the page.

Zoom Out See more of the page, but less detail.

Close Return from print preview to the main TreeChart window.

See Also
Print dialog box



 Print Setup command (File menu)

Use this command to select a printer, a printer connection or other printer-specific options.

See Also
Print Setup dialog box
Printing charts



 Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer Select the printer you want to use. Choose the Default Printer; or 
choose the Specific Printer option and select one of the current 
installed printers shown in the box. You install printers and configure 
ports using the Windows Control Panel.

Orientation Choose Portrait or Landscape.

Paper Size Select the size of paper that the chart is to be printed on.

Paper Source Some printers offer multiple trays for different paper sources. Specify 
the tray here.

Options Displays a dialog box where you can make additional choices about 
printing, specific to the type of printer you have selected.

Network Choose this button to connect to a network location, assigning it a new 
drive letter.

See Also
Keys for working with dialog boxes
Printing charts



 Layout menu commands

The Layout menu offers the following commands:

Define 
Layouts

Define Layouts.

Text Styles Make a series of changes to the text style of any group of fields within 
any group of Layouts.

Edit Edit the Layout used by the Current Box.
Size Modify the box size rules of the Layout used by the Current Box.
Spacing Modify the spacing rules of the Layout used by the Current Box.
Use Default Selected boxes use their Default Layouts.
Defaults Define a default Layout for each level in the chart.
Delete 
Unused

Delete unused Layouts.



 Define Layouts command (Layout menu)

Use this command to create a new Layout, rename a Layout or change which Layout is used 
by the selected boxes.

Shortcuts

Toolbar:
Keys: CTRL+D

See Also
Define Layouts dialog box



 Edit Layout command (Layout menu)

Use this command to edit the Layout used by the Current Box.

To edit other Layouts, use the Define Layouts command.

To simultaneously change the text styles of any group of fields within any group of Layouts, 
use the Text Styles command.

Shortcuts
Mouse: SHIFT+double click on box
Keys: SHIFT+ENTER

See Also
Define Layouts command
Edit Layout dialog box
Text Styles command



 Box Size command (Layout menu)

Use this command to change the box size settings of the Layout used by the Current Box.    

To change the box size settings of other Layouts, use the Define Layouts command.

Shortcuts
Keys: F8

See Also
Box Size dialog box
Define Layouts command



 Box Spacing command (Layout menu)

Use this command to change the box spacing settings of the Layout used by the Current 
Box.

To change the box spacing settings of other Layouts, use the Define Layouts command.

Shortcuts
Keys: SHIFT+F8

See Also
Box Spacing dialog box
Define Layouts command



 Use Default Layouts command (Layout menu)

Use this command to instruct TreeChart to set all selected boxes to use the Default Layout 
defined for their level in the chart.

If no boxes are selected, the command changes the Layout used by the Current Box.

Default Layouts are defined using the Default Layouts command.

Shortcuts
Keys: CTRL+U

See Also
Default Layouts command
Selecting Boxes



 Default Layouts command (Layout menu)

Use this command to change the Default Layouts.

See Also
Default Layouts dialog box



 Delete Unused Layouts command (Layout menu)

Use this command to delete any Layouts you no longer need.

You cannot delete a Layout if it is used by any box or one of the Default Layouts.

See Also
Delete Layouts dialog box



 Define Layouts dialog box

This dialog allows:

New Layouts to be created

Existing Layouts to be renamed or edited

Different Layouts to be used for selected boxes

Default Layouts to be changed

Unused Layouts to be deleted

The dialog lists all existing Layouts, with the Layout used by the Current Box selected 
automatically.

Choose the Close button to complete the dialog and return to your chart window.

The dialog has a Close button rather than OK and Cancel since all of the operations available
from this dialog are performed immediately, and cannot be undone. Most of these 
operations, however, are actually performed via secondary dialogs, and in these secondary 
dialogs you have the choice whether to proceed with or cancel changes you have made.

To create a new Layout

Newly created Layouts are always a copy of an existing Layout. When selecting an existing 
Layout, choose one that most closely matches how you'd like the new Layout to look. This 
will minimize the number of changes you need to make when you edit the new Layout.

1 Select an existing Layout
2 Enter the name of the new Layout in the New Name edit control.
3 Choose the New button

Layout names must be unique. If you try to create a new Layout with the same name as an 
existing Layout, TreeChart will refuse to accept the name.

The newly-created Layout will be added to the Layout list, and automatically selected, since 
you are almost certain to want to edit it.

Creating a new Layout takes immediate effect, and cannot be undone. If you make a 
mistake, you should either Rename or Delete the new Layout.

To edit a Layout

1 Select the Layout you wish to edit.
2 Choose the Edit button.

As an alternative, you can double-click on the Layout name.

To rename a Layout



1 Select the Layout you wish to rename
2 Enter the new name in the edit control.
3 Choose the Rename button

Layout names must be unique. If you try to rename a Layout with the same name as an 
existing Layout, TreeChart will refuse to accept the name.

Renaming a Layout takes immediate effect, and cannot be undone. If you make a mistake, 
you should repeat the Rename operation.

To use a Layout for selected boxes

1 Select the boxes before you enter the Define Layouts dialog.
2 Select the Layout the selected boxes should use.
3 Choose the Use button

Using a different Layout takes immediate effect, and cannot be undone. If you make a 
mistake, you should repeat the Use operation.

To change the Default Layouts

Choose the Defaults button.

To delete unused Layouts

Choose the Delete button.

See Also
Default Layouts dialog
Delete Unused Layouts dialog
Edit Layout dialog
Keys for working with dialog boxes
Selecting Boxes



 Edit Layout dialog box

This dialog allows you to change all settings of a single Layout.

The settings are divided into three basic groups:

Text options The style, position and visibility of each Text Field
Box options How the box itself is drawn
Connections options How this box and its subordinates are positioned and connected

The sample uses the names of Text Fields to indicate their position and appearance.

After making    changes, choose OK to complete the dialog. The changes will automatically 
affect any box using this Layout.

Choose Cancel to complete the dialog, ignoring every change you have made.

See Also
Box options
Connections options
Keys for working with dialog boxes
Text options



 Edit Layout dialog box: Text Options
This group of controls allows you to change all options affecting how each Text Field appears 
for all boxes using this Layout.

Field Choose the Text Field whose settings you want to change. As well as 
fields that you have defined, a number of automatically calculated 
fields are listed.

All remaining options affect the currently selected field.

Hide Select this checkbox to hide the field.

Font Choose this button to change the field's font, style, size or color.

Options Choose this button to change the field's width or added text.

Horiz. Alignment Use these controls to change the field's position and alignment within a
line of text. Fields can be aligned with the left, the right or the center of
the box. The < and > buttons nudge the field sideways.

Vertical Alignment Use these controls to change the field's vertical alignment relative to 
the box. The Up and Down buttons nudge the field vertically, creating 
or merging lines as necessary.

See Also
Automatically Calculated Fields
Choose Font dialog
Keys for working with dialog boxes
Text Field Options dialog



 Edit Layout dialog box: Box Options

This group of controls allows you to change all options affecting how the actual box appears 
for all boxes using this Layout.

Shape Choose the basic shape of the box. This can be modified by choosing a 
fixed height to width ratio when specifying the box size.

Border Width Choose the thickness of the box's border (including no border).

Border Color Choose this button to change the border color.

Fill Color Choose this color to change the box's interior color.

Transparent Select this checkbox to ignore the Fill Color. The interior color will 
automatically be the same as whatever is behind the box.

Shadow Choose the shadow thickness and direction (including no shadow).

Shadow Color Choose this button to change the shadow color.

Size Choose this button to change the margins between the text and the 
box border, or to specify a minimum box size or a fixed height to width 
ratio.

See Also
Box Size dialog
Choose Color dialog
Keys for working with dialog boxes



 Edit Layout dialog box: Connections Options

This group of controls allows you to change all options affecting how all boxes using this 
Layout are positioned with their subordinates, and how connecting lines are drawn.

Style Choose from a list of preset styles that determine both box positioning 
and line routing.

Child Align Choose how subordinates will be aligned as they are positioned.

Spacing Choose this button to change the spacing between boxes.

Line Width Choose the thickness of connecting lines (including no lines).

Line Color Choose this button to change the color of connecting lines.

See Also
Box Spacing dialog
Choose Color dialog
Connection Style Options
Keys for working with dialog boxes
Subordinate Alignment Options



 Connection Style Options
The Layout used by a box determines how that box is positioned with, and connected to, its 
immediate subordinates. Normally, each subordinate is positioned and connected uniformly, 
though you can mark boxes as exceptions to the rules.

The most significant Layout setting for box positioning is chosen in the Connections Style 
drop-down list in the Edit Layout dialog. This list is pictorial, so most options should generally
be obvious. The sample within the Edit Layout dialog reflects the current setting.

See Also
Aligning a box relative to its subordinates
Boxes that frame subordinate sub-trees
Edit Layout dialog box
Marking Boxes as Exceptions to the Rules
Positioning some subordinates across and some down
Stretching a box to cover its subordinates



 Stretching a box to cover its subordinates
Some of the options in the Connections Style drop-down list in the Edit Layout dialog have 
a box drawn wider than normal.

If one of these options is selected for a Layout, all boxes using that Layout will automatically 
be stretched to 'cover' their immediate subordinates.

For example:

Stretching boxes is done after calculating their minimum size and size matching; if a box is 
already bigger than its 'stretched' size, it will not be made smaller.

See Also
Edit Layout dialog box



 Aligning a box relative to its subordinates
The options in the Connections Style drop-down list in the Edit Layout dialog indicate how 
a box using this Layout will be positioned relative to its subordinates after those 
subordinates have been positioned across the page, down the page or a mixture of the two.

The options can be summarized as follows:

The parent connection point is the left edge of the left-most subordinate - Offset margin

The parent center is the mid-point between the left-most and right-most subordinate edges

The parent connection point is the right edge of the right-most subordinate + Offset margin

For example:

The following options are only available where subordinates are placed across:

The parent center matches the center of left-most subordinate

The parent center matches the center of subordinate nearest the mid-point

The parent center matches the center of right-most subordinate

For example:

Options that make use of the Offset Distance margin are indicated with a filled box. Options 
that ignore the Offset Distance margin are indicated with a hollow box. The Offset Distance 
margin can be set using the Box Spacing dialog.

Not all styles offer all alignment options.

See Also
Box Spacing dialog
Edit Layout dialog box



 Boxes that frame subordinate sub-trees
Some of the options in the Connections Style drop-down list in the Edit Layout dialog 
indicate a box surrounding, or framing, other boxes.

If one of these options is selected for a Layout, all boxes using that Layout will automatically 
be stretched and positioned to frame their subordinate sub-trees.

For example:

The subordinate sub-trees replace any vertically-centered text. Any vertically centered text 
is normally hidden, but will be shown if the box has no subordinates, or if its subordinates 
have been hidden by using outlining techniques.

The distinction between Box Size and Box Spacing is less obvious with these styles: the 
distances between subordinates are specified in the Box Spacing dialog, while the distances 
between the subordinates and the frame (& its text) are specified in the Box Size dialog.

You can specify a specific aspect ratio for a framing box, but not a minimum size. 
Surrounding boxes are also ignored when matching box sizes.

If you select a box which frames other boxes, it is highlighted slightly differently: instead of 
inverting the whole box, only the area outside the surrounded sub-trees is inverted.

If you use outlining to Focus on a framed sub-tree, you can choose whether TreeChart 
regards the frame color as the chart background color, or whether the Border background 
color is retained.

See Also
Adding titles and a border
Box Size dialog
Box Spacing dialog
Edit Layout dialog box
Outlining



 Positioning some subordinates across and some down
Some of the options in the Connections Style drop-down list in the Edit Layout dialog 
indicate some subordinates being placed across the page while some are placed down.

If one of these options is selected for a Layout, all boxes using that Layout will have their 
subordinates positioned dependent on whether or not they themselves have subordinates.

Subordinates that have subordinates will be placed across the page

Subordinates that don't have subordinates will be listed

For example:

In an Organization Chart, managers would be positioned across, while non-managers would 
be listed. In a parts list, sub-assemblies would be positioned across, while individual 
components would be listed.

Using outlining techniques has no effect on this: a collapsed box still has subordinates, even 
though its subordinates are hidden.

The order of subordinates is significant for these styles, since only adjacent subordinates are
formed into a list. To get the best results, you may need to swap subordinate positions.

If you find that subordinates have unexpectedly been grouped into two lists, its probably 
because you've marked one of the subordinates as an Assistant. To group them    into a 
single list, swap the position of the Assistant with another box.

Since these styles are hybrids of the basic across or down styles, they use both sets of 
distances to specify the spacing between boxes.

See Also
Box Spacing dialog
Edit Layout dialog box
Outlining
Swap command



 Subordinate Alignment Options

The Child Align list in the Connections section of the Edit Layout dialog determines how 
subordinates of a box using this Layout are aligned as they positioned across or down the 
page.

There are six options: three align subordinate boxes, and three align subordinate sub-
trees.

Subordinates placed Across

align subordinate tops align subordinate centers align subordinate bottoms

align sub-tree tops align sub-tree centers align sub-tree bottoms

Some Connections Styles list some subordinates, then place remaining subordinates across. 
Listed subordinates are always left-aligned, then treated as a single large box when aligning 
with the remaining subordinates.

Subordinates placed Down

align subordinate left edges align subordinate centers align subordinate right edges

align sub-tree left edges align sub-tree centers align sub-tree right edges



 Box Size dialog box

The size of a box is determined by four factors:

How much space is needed to show the text (with the selected font settings)

The distance between the text fields and the box border

Any Layout-dependent size rules

Any chart-wide size matching rules

The first factor depends on the box text and the Layout's Text Options.

This dialog allows you to change the second and third factors.

See Also
Edit Layout dialog box
Entering Measurements
Keys for working with dialog boxes
Layout-dependent size rules
Match Box Sizes dialog box
The distance between text fields and the box border



 Box Size dialog box: Text Margins

Boxes are always big enough to contain their associated text, then various margins are 
added before determining the actual box size. The meaning of the eight margins is 
illustrated by the following diagram:

Text fields having the same vertical alignment always have single line spacing.

The Above, Below, TopMiddle and BottomMiddle margins are only used if there are text fields
above, below, top or bottom vertically aligned respectively. If this is not the case, these 
margins are totally ignored and have no effect on box size or spacing.

The Top, Bottom, Left and Right margins have, in a sense, two meanings:

In determining the initial box size, TreeChart calculates how much space is needed for the 
text, then adds these margins to determine an initial box size. If Box Size rules specify a 
minimum, or the chart-wide size matching rules require equal sized boxes, the box may then
be made bigger.

When drawing a box, these margins are subtracted from the box size to determine where 
to place text. The overall effect, therefore, is that right-aligned text field (for example) will 
always be a fixed distance from the right edge of the box, irrespective of how wide the box is
made to satisfy Size Matching rules.

Note that centered text (both vertically and horizontally) is centered within the region 
defined by the final box size minus the Top, Bottom, Left and Right margins. If your Top and 
Bottom margins aren't equal, or if your Left and Right margins aren't equal, the text will not 
be centered with respect to the box.

The checkboxes Push Out Above and Push Out Below determine the Left and Right 
margins for text fields above and below the box. Text fields inside the box are always inside 
the left and right sides of the box (the distance inside being determined by the Left and 
Right margins). Text fields above and below the box normally use the same Left and Right 
margins, but if the corresponding checkbox is selected instead regard the outer edge of the 
box as the left and right margins. The actual placement of text fields still depends on the 
horizontal alignment selected in the Edit Layout dialog.

See Also
Entering Measurements
Keys for working with dialog boxes



Match Box Sizes dialog box



 Box Size dialog box: Size Control

Box size calculation is by default automatic: box size being the space needed for the text 
plus margins. You can optionally specify a minimum height and/or width for a box.

Treat Minima as Fixed Ratio

Select this checkbox to cause boxes using this Layout to have a fixed height to width ratio. 
This checkbox is available only if you have specified both a minimum height and a minimum 
width.

Two examples:

To make rectangular box shapes square, or elliptical box shapes circular, select a minimum 
height and width of zero, and select Fixed Ratio. Since the minima specified are zero, there is
effectively no minimum size to a box, but they will always be square (or circular) since the 
ratio is 1:1.

To make boxes have a 5x3 proportion, and have a minimum width of 2.5cm, select a 
minimum width of 2.5cm and a minimum height of 1.5cm, and select Fixed Ratio.

Selecting a fixed aspect ratio for a box affects the operation of any size-matching rules you 
may specify for the chart.

See Also
Entering Measurements
Keys for working with dialog boxes
Match Box Sizes dialog box



 Box Spacing dialog box

This dialog allows you to specify the various Layout factors affecting the spacing of boxes.

Up to six distances can be specified. The distances actually used depend on the 
arrangement of the box and its subordinates, as specified in the Connections Style list when
editing the Layout used by the parent box.

Minimum Distance between this box and subordinates

Used by all styles except those that frame subordinate sub-trees. When the parent is above 
its subordinates, this is the vertical distance between the bottom of the parent and the top 
of the subordinates. When the parent is beside its subordinates, this is the horizontal 
distance between the parent and its subordinates. For example:

    

    

Minimum Vertical and Horizontal Distances between subordinates

Used in all styles to specify how close together subordinate sub-trees should be positioned. 
Subordinate sub-trees are normally positioned so as to minimize the size of the chart. This 
can involve tucking sub-trees into or under gaps in other subordinate sub-trees. For 
Example:

      

 If you prefer isolated sub-trees, select the Prevent Subordinate Sub-trees Overlapping 
checkbox.



Offset Distance between this box and subordinates

Used only by certain styles (those with a solid fill to the parent box in the Style list). This 
indicates the horizontal offset from the point at which the connecting line leaves the parent 
box to the left or right edge of the subordinates. For example:

      

      

Vertical and Horizontal Stem Distances

Used where the connecting line has a common portion, with a stem drawn from the parent 
or to each subordinate. These indicate the length of the stem. Also used to position 
Assistants. For example:

      

      

See Also
Assistants
Entering Measurements
Keys for working with dialog boxes



 Default Layouts dialog box

This dialog allows you to specify which Layout is initially used by a newly-inserted box.    You 
can specify a different Default Layout for each level in your chart.

The Default Layout for a particular level is determined as a two-step process:

If there is a specific Layout named as Default for this level, use it

If there is no specific Layout named for this level, use a chart-wide default

The chart-wide default can be selected from the Default drop-down list.

Defaults for specific levels can be selected from the level-specific drop-down lists. If you 
don't want to name a specific Layout as default for a level, just select '(default)' in the list.

Only eight levels can have defaults specified, any boxes inserted at levels nine and above 
will always use the chart-wide default.

Choose the OK button to complete the dialog and implement the changes you
have made. Choose the Cancel button to abandon the dialog, leaving your Default Layouts 
unchanged.

See Also
Keys for marking boxes as exceptions to the rules



 Delete Unused Layouts dialog box

This dialog allows you to delete any Layouts you no longer need.

TreeChart will not allow you to delete Layouts that are being used. If a Layout is named as a 
Default Layout, it is considered to be in use, even if no box is actually using it.

All currently unused Layouts are listed. Select the Layout(s) you wish to delete.

Choose the OK button to complete the dialog, and delete all selected Layouts.

Choose the Cancel button to abandon the dialog, leaving layouts untouched.

See Also
Keys for working with dialog boxes



 Chart menu commands

The Chart menu offers the following commands:

Define Fields Define box text fields.
Border Fields Define Border text fields.
Border Text Edit the Border text.
Border Layout Change the Border Layout.
Border 
Margins

Change the Border margins.

Match Box 
Sizes

Change the box size-matching rules.

Page Setup Change page margins and print style.



 Define Text Fields command (Chart menu)

Use this command to add a new text field or rename or delete an existing text field. All 
boxes in a chart have the same number of text fields.

Shortcuts
Keys: F3

See Also
Define Text Fields dialog box



 Define Border Text Fields command (Chart menu)

Use this command to add a new Border text field or rename or delete an existing Border text
field. Border text fields are independent of box text fields.

Shortcuts
Keys: SHIFT+F3

See Also
Define Text Fields dialog box



 Edit Border Text command (Chart menu)

Use this command to edit Border text.

Shortcuts
Mouse: double click on chart background
Keys: F7

See Also
Edit Text Fields dialog box



 Border Layout command (Chart menu)

Use this command to change the appearance of the Border.

Shortcuts
Mouse: SHIFT+double click on chart background
Keys: SHIFT+F7

See Also
Edit Border Layout dialog box



 Border Margins command (Chart menu)

Use this command to change the margins of the Border.

Shortcuts
Keys: CTRL+F7

See Also
Border Margins dialog box



 Match Box Sizes command (Chart menu)

Use this command to change the rules for matching box sizes throughout the chart.

See Also
Match Box Sizes dialog box



 Page Setup command (Chart menu)

Use this command to change the margins used when printing, and whether TreeChart should
print your chart at its correct size or shrink it to fit on a single page.

See Also
Page Setup dialog box



 Define Text Fields / Define Border Text Fields dialog boxes

These dialog boxes allow you to change the text fields available within boxes or the Border.

You can build up a series of changes to the text fields, then proceed to alter the chart or 
cancel the changes.

To Rename an existing Field:

1 Select the existing Field you wish to rename
2 Enter the new name of the Field in the New Name control
3 Choose the Rename button

The Rename button is only enabled when text has been entered in the New Name control, 
and one Field has been selected.

Field Names must be unique, and an error message is shown if you attempt to rename a 
Field to using Name which is already in use

To Add a new Field:

1 Enter the name of the Field you wish to add in the New Name control
2 Choose the Add button

The Add button is only enabled when text has been entered in the New Name control.

Field Names must be unique, and an error message is shown if you attempt to add a Field to 
using an Name which is already in use.

To Delete an existing Field:

1 Select the Field (or Fields) you wish to delete
2 Choose the Delete button

The Delete button is only enabled when at least one Field has been selected, and when no 
text has been entered into the New Name control.

Any number of Fields can be deleted in one operation by selecting a group of Field Names.

Completing the dialog:

After changing the Field definitions, choosing the OK button causes the changes to be 
applied to your chart.

Choosing the Cancel button cancels the dialog leaving your chart unchanged.

Box Text Fields:

For newly added Fields, all boxes and Layouts will have the Field added. Box text for this 
Field will initially be empty, and the Field will initially be hidden. You will need to edit each 
Layout in which you want the Field to be visible.



For deleted Fields, all boxes and Layouts will have the Field deleted.

Border Text Fields:

For newly added Fields, text for this Field will initially be empty, and the Field will initially be 
visible. You will need to edit the Border Layout if the default font or position of newly added 
Border Fields is not as you wish.

See Also
Keys for working with dialog boxes



 Border Margins dialog box

This dialog allows you to specify the various Layout factors affecting the relative positioning 
of your chart and the Border text fields within the Border.

The Border Margins specify the minimum distance between your chart and the border, and 
the absolute distance between the border and the Border Text Fields.

When adding the Border to your chart, the margins are interpreted in two different ways:

When copying a picture of your chart to the Clipboard, or saving as a picture-format file, the
Border (and Border Margins) are added to your chart. The picture will always be bigger than
your chart; the extra area being the Border.

When printing your chart, the Page Margins are subtracted from the paper size to determine
where the Border is. The Border Margins are then also subtracted to leave an area of paper
available for the chart itself; what happens then depends on what printing style (poster or 
fit-
to-page) you have selected.

The meaning of the eight margins is illustrated by the following diagram:

Text fields having the same vertical alignment always have single line spacing.

The Above, Below, TopMiddle and BottomMiddle margins are only used if there are text fields
above, below, top or bottom vertically aligned respectively. If this is not the case, these 
margins are totally ignored.

The checkboxes Push Out Above and Push Out Below determine the Left and Right 
margins for text fields above and below the border. Text fields inside the border are always 
inside the left and right sides of the border (the distance inside being determined by the Left
and Right margins). Text fields above and below the border normally use the same Left and 
Right margins, but if the corresponding checkbox is selected instead regard the outer edge 
of the border as the left and right margins. The actual placement of text fields still depends 
on the horizontal alignment selected in the Edit Border Layout dialog.

See Also
Entering Measurements
Keys for working with dialog boxes





 Match Box Sizes dialog box

While the size of individual boxes is determined by the text that they contain, and Layout 
options like Fonts & Box Size, TreeChart also offers a variety of options for matching box 
sizes.

The height and width of boxes can be controlled independently; select one radio button from
each group:

Independent No further size corrections are applied.
Equal Throughout Chart All Boxes will be drawn the same size.
Equal Within Levels All Boxes at the same level will have the same 

size.
Equal Among 
Subordinates

All Boxes having the same Parent will have the 
same size.

Equal Using Layouts All Boxes using the same Layout will have the 
same size.

You can also mark specific boxes to be ignored when matching heights or widths.

Wherever box sizes are changed, they are always increased to match the size of the largest 
box in the chosen category.

All boxes using the same Layout implicitly have the same height. The height of a box is 
determined by which fields are present, their font sizes and the box margins; it is not 
determined by the height of the actual text in the fields.

Deciding what boxes are compared

The radio buttons selecting the scope of the scan for size matching is useful when outlining 
facilities are in use. Matching box sizes within the Current View produces the most attractive 
individual charts. Matching box sizes throughout the whole chart is useful when you want 
consistent box sizes over a set of sub-charts prepared using outlining.

Select Current View to make boxes match the largest visible box.

Select Entire Chart to make boxes match the largest box in the entire chart.

Size matching rules and fixed-ratio boxes

You can specify a fixed height to width ratio for boxes using a Layout. This interferes with the
strict appliance of size matching rules. In these circumstances the height of such a box will 
obey the size matching rules, and the width of the box is then re-calculated to obey the 
aspect ratio rule.

See Also
Keys for working with dialog boxes
Marking Boxes as Exceptions to the Rules
Outlining



 Page Setup dialog box

This dialog allows you to specify how TreeChart fits your chart and its Border to sheets of 
paper when printing.

Margins

The margins specify the distance from the edge of the paper to the center of the border.

Many printers have a small non-printable area at the edge of the paper. If the margins 
you choose would cause any part of the chart or Border not to be printed correctly with 
the selected printer, your margins will automatically be adjusted.

To change the margins between the border and the Border text fields, or between the 
border and your chart, use the Border Margins command.

Print Style

Select Poster to print your chart at its actual size. If the chart doesn't fit on a single 
sheet of paper, it will be printed on a series of sheets which you must then stick together.

Select Overlapped Poster to print your chart at its actual size. If the chart doesn't fit on
a single sheet of paper, it will be printed on a series of sheets which you must then stick 
together. Where page breaks occur, ¼" of the chart is printed on both sheets.

Select Fit To Page to print your chart on a single sheet of paper. TreeChart automatically
shrinks all box and font sizes in proportion to make the chart fit.

Chart Alignment

Choose where your chart will be printed within the area left after allowing for the Border.

See Also
Border Margins command
Entering Measurements
Keys for working with dialog boxes



 Entering Measurements

A number of dialogs within TreeChart permit you to enter absolute measurements (margins, 
for example).    Entering measurements is handled in a consistent fashion:

Measurements can be presented in either metric or imperial units (centimetres or inches).

All dialogs containing measurements offer radio buttons to select the units the 
measurements are to be presented in. All measurements within a dialog are presented in the
same units.

When a dialog containing measurements appears, the units will be as you last selected 
them. The units on program startup are read from an initialization file, and will be as you last
selected them last time the program was run.    If the units cannot be read from the 
initialization file, the program uses the units specified by the International section of the 
Windows Control Panel.

The number of decimal places used when measurements are presented is as selected in the 
International section of the Windows Control Panel.

The decimal separator used when measurements are presented is as selected in the 
International section of the Windows Control Panel.    This decimal separator must also 
be used when you enter measurements.

You can enter measurements in a variety of units, for example:

3 in 4.25" 2.1 cm 15mm 72pt (points) 16pi (pica)

Spaces between number and units are ignored. If no units are specified, the current 
presentation units (centimetres or inches) are assumed.

As an alternative to typing a new value, you can adjust the value by clicking on the 
increment / decrement controls associated with each measurement.

All measurements used by TreeChart must be in the range 0"-22" approximately. Attempting 
to enter values outside this range results in an error message when you change presentation
units or complete the dialog.



 Chart Window Mouse Operations

TreeChart only uses the left button on the mouse, or the right button if the mouse buttons 
have been reversed by settings in the Windows Control Panel.

Quick summary of standard Windows mouse techniques:

Click move the mouse
press & release the left mouse button

Double-Clickmove the mouse
quickly press & release the left mouse button twice

Drag move the mouse
press (and hold down) the left mouse button
move the mouse
release the left mouse button to complete the operation

Click & double-click actions largely depend on whether or not the mouse pointer is over a 
box when you press the mouse button. When you're pointing at a box, the cursor changes:

pointer on a box

pointer on the chart background

Inserting a new box:

You can insert a new box by dragging from an existing box:

1 Move the mouse over the box you want to insert above, below, left of or right of.

2 Press (and hold down) the left mouse button. This is called the Start Position.

3 Move the mouse. Depending on the distance from the Start Position, and the position 
relative to the Start Position, the mouse cursor will change:

Near Start Position - abandon insert

Above Start Position - Insert box above existing 
box

Below Start Position - Insert box below existing 
box

Left of Start Position - Insert box left of existing 
box

Right of Start Position - Insert box right of existing 
box

4 Release the left mouse button to complete the operation, the action taken depends 
on the cursor that was shown when you release the button.

Summary of Chart Window Operations:



To with the mouse

Move Insertion Point click on box
Edit box Text Fields double-click on box
Edit Layout used by box SHIFT+double-click on box

Edit the Border Text double-click on chart background
Edit the Border Layout SHIFT+double-click on chart background

Insert a box in an empty chart or 
view

drag on chart background

Insert a box above existing box drag up from existing box
Insert a box below existing box drag down from existing box
Insert a box left of existing box drag left from existing box
Insert a box right of existing box drag right from existing box
Abandon box insertion drag back to starting point

Toggle box selection status CTRL+click on box
Clear Selections click on chart background
Select a group of boxes drag selection rectangle on chart background
Add a group of boxes to current 
selection

CTRL+drag selection rectangle on chart background

Note: The last two operations automatically scroll the chart window to keep the cursor visible.

See Also
Inserting Boxes



 Edit Border Layout dialog box

This dialog allows you to change all Border Layout settings.

The settings are divided into two basic groups:

Text options The style, position and visibility of each Text Field
Border options How the border itself is drawn

The sample uses the names of Border Text Fields to indicate their position and appearance.

After making    changes, choose OK to complete the dialog and change the Border

Choose Cancel to complete the dialog, ignoring every change you have made.

See Also
Border options
Keys for working with dialog boxes
Text options



 Edit Border Layout dialog box: Text Options
This group of controls allows you to change all options affecting how Border text appears.

Field Choose the Text Field whose settings you want to change. As well as 
fields that you have defined, a number of automatically calculated 
fields are listed.

All remaining options affect the currently selected field.

Hide Select this checkbox to hide the field.

Font Choose this button to change the field's font, style, size or color.

Options Choose this button to change the field's width or added text.

Horiz. Alignment Use these controls to change the field's position and alignment within a
line of text. Fields can be aligned with the left, the right or the center of
the border. The < and > buttons nudge the field sideways.

Vertical Alignment Use these controls to change the field's vertical alignment relative to 
the border. The Up and Down buttons nudge the field vertically, 
creating or merging lines as necessary.

See Also
Automatically Calculated Fields
Choose Font dialog
Keys for working with dialog boxes
Text Field Options dialog



 Edit Border Layout dialog box: Border Options

This group of controls allows you to change all options affecting how the actual border 
appears.

Shape Choose the basic shape of the border.

Line Width Choose the thickness of the border (including no border).

Border Color Choose this button to change the border color.

Shadow Choose the shadow thickness and direction (including no 
shadow).

Shadow Color Choose this button to change the shadow color.

Margins Choose this button to change the margins between the text and 
the border or between the border and the chart.

Background Color Choose this color to change the chart background color.

Fixed Background Color This checkbox determines how the chart background should be 
treated under certain outlining conditions. If this checkbox is 
selected, the Border Background color you choose will always be
used. If this checkbox is clear, the chart background color may 
change as you change your outlining selections.

See Also
Border Margins dialog
Choose Color dialog
Keys for working with dialog boxes
Outlining
The chart background color



 View menu commands

The View menu offers the following commands:

Toolbar Show or hide the Toolbar.
Status Bar Show or hide the Status Bar.
View All Show all boxes, by removing Focus & expanding collapsed boxes.
Focus Focus on Sub-Tree or the whole chart.
Collapse Collapse selected boxes, making boxes below them hidden.
Expand Expand selected boxes, revealing hidden boxes.
Expand All Expand all collapsed boxes, revealing hidden boxes.
Zoom In Zoom in, to magnify a portion of the chart.
Zoom Out Zoom out, to see more of the chart.
Zoom Normal Restore to 100% zoom.



 View All command (View menu)

Use this command to remove all outlining selections you have made, and view the entire 
chart.

Focus is restored to the whole tree, and all collapsed boxes are expanded.

Shortcuts

Toolbar:
Keys: CTRL+Q

See Also:
Outlining



 Focus command (View menu)

Use this command to focus on one sub-tree of your chart, and hide all boxes not on that sub-
tree.

This command switches between focusing on the whole tree and any sub-tree. When you are
focused on a sub-tree, the menu item has a check mark beside it. Selecting this command 
again restores focus to the whole tree.

When focus is applied, the Current Box, and all boxes below it remain visible. All other boxes 
are hidden.

The Focus command can affect the chart background color.

Shortcuts

Toolbar:
Keys: CTRL+F

See Also:
The Chart Background Color
Outlining



 Collapse command (View menu)

Use this command to hide some of the detail of your chart. The command collapses the 
selected boxes; all boxes below these become hidden.

Shortcuts

Toolbar:
Keys: CTRL+K

See Also:
Outlining
Selecting Boxes



 Expand command (View menu)

Use this command to reveal boxes hidden using the Collapse command. This command 
expands the selected boxes; all boxes below these are revealed.

You may have previously collapsed some of the revealed boxes. These boxes will remain 
collapsed unless you expand them. To expand all boxes use the Expand All command.

Shortcuts

Toolbar:
Keys: CTRL+E

See Also:
Collapse command
Expand All command
Outlining
Selecting Boxes



 Expand All command (View menu)

Use this command to reveal boxes hidden using the Collapse command. This command 
expands all collapsed boxes, revealing all hidden boxes.

Shortcuts

Toolbar:
Keys: CTRL+SHIFT+E

See Also:
Collapse command
Outlining



 Outlining
Outlining is the technique offered by more sophisticated word processors to allow you to 
hide parts of a document, and concentrate on other parts.

For example, this describes the structure of a simple document:

The Document
Chapter 1

Section 1
Section 2

Sub-section 1
Sub-section 2

Chapter 2
Section 1
Section 2

Showing the document in this form already illustrates one aspect of outlining: hiding the 
actual text within each section or sub-section, and just concentrating on the section 
headings. This will have been achieved by using a command to collapse the sections.

If you wanted to edit the text within Chapter 1, Section 1, this heading would be expanded 
to show the text beneath it.

Another example of outlining that you may be familiar with is the directory windows of the 
Windows File Manager.

TreeChart offers outlining to perform much the same function: hiding some aspects of your 
chart, and allowing you to better concentrate on other aspects.

The outlining selections you make define the Current View of the chart.

The example document we described above could be shown in TreeChart terms like this:

If you just wanted to have a 'top-level' view of the chart, you could select the two 'Chapter' 
boxes, then use the Collapse command. The chart would be redrawn like this:

Notice that when recalculating the box positions, the 'Chapter' boxes are now placed much 
closer together. Box placement depends only on visible boxes, so that the chart looks 
attractive whatever outlining selections you have chosen.

In an Organization Chart, Collapse is useful for viewing management, and hiding other staff.



You reveal whatevers hidden below collapsed boxes by expanding them. Two commands do 
this: the Expand command expands the selected boxes, while the Expand All command 
expands all collapsed boxes.

As well as hiding things below a box, TreeChart also allows you to hide things above a box. 
Returning to the original chart, we can focus our attention on Chapter 1 by making the 
'Chapter 1' box the Current Box, then using the Focus command. The chart would be 
redrawn like this:

In saying that this hides all boxes above the Current Box, we're being a bit inaccurate; what 
the Focus command really does is leave only the Current Box and all boxes below it visible; 
all boxes above it or on different branches are hidden.

In an Organization Chart, Focus is useful for viewing just one department, and hiding all 
others.

You can only focus on one box at a time. To remove the focus, and reveal the true top-level 
box, choose the command again.

If the box you have focused on 'disappears', the focus is automatically moved to the parent 
of the box that had the focus. This is done to ensure that you can always see the context 
you're working in. A box can 'disappear' in two ways: by being deleted, or if you collapse a 
box marked as Invisible.

The Focus & Collapse commands can be combined. For example, you might wish to focus
on Chapter 1, and then collapse the Section boxes to give you this:

The View All command removes focus and expands all collapsed boxes.

See Also:
Collapse command
Expand command
Expand All command
Focus command
Keys for hiding boxes (outlining)
The Chart Background Color
View All command



 Zoom In command (View menu)

Use this command to increase the zoom factor used when your chart is displayed.

Zoom factors greater than 100% cause boxes to be displayed larger than when they are 
printed, making small text sizes easier to read.

This command is ignored if the zoom factor is already at its maximum value.

Shortcuts
Keys: +

See Also:
The Toolbar
Zooming the Chart Display



 Zoom Out command (View menu)

Use this command to decrease the zoom factor used when your chart is displayed.

Zoom factors less than 100% cause boxes to be displayed smaller than when they are 
printed, allowing you to see more boxes at once, though text becomes unreadable.

This command is ignored if the zoom factor is already at its minimum value.

Shortcuts
Keys: -

See Also:
The Toolbar
Zooming the Chart Display



 Zoom Normal command (View menu)

Use this command to restore the zoom factor to 100%. The displayed size of boxes will now 
match the printed size.

Shortcuts
Keys: =

See Also:
The Toolbar
Zooming the Chart Display



 Zooming the Chart Display

TreeChart normally displays your chart at full size. You can elect to display the chart with 
various
scaling or zoom factors, to see more of the structure of the chart (but with illegible text) or 
more
clearly see small text sizes (but fewer boxes).

All methods for moving around and editing your chart are available whatever the zoom 
factor.

The current zoom factor (for the active chart) is indicated on the Toolbar.

To restore normal (100%) zoom:

Use the Zoom Normal command.

To set a specific zoom factor:

A specific zoom factor can only be set if the Toolbar is shown. To set a specific zoom factor, 
open the drop-down list on the Toolbar, and select the desired zoom factor. Keyboard users 
can access this list:

F2 Opens the list
arrow keys change selection
ENTER confirm selection (closes list)

To increment or decrement the zoom factor:

Use the Zoom In or Out commands.

These commands move to the next preset zoom factor. They are ignored if you are already 
displaying the chart at maximum / minimum zoom.

See Also:
The Toolbar
Zoom In command
Zoom Out command
Zoom Normal command



 The Chart Background Color

The Background color you select for the Border is the background color for the chart.

To assist you in selecting complimentary colors for the boxes, lines and text in your chart, this 
background color is used for the chart window, and when changing Layout settings.

Some of the box positioning styles cause boxes to be framed by other boxes. The background color of the
framed boxes is therefore the Fill color of the framing box.

If you use outlining techniques to Focus on a framed box, and hide all boxes above it and on different 
branches, you might want to temporarily adopt the framing box's Fill color as the chart background color, 
rather than continue to use the Border Background color. This option is a Border Layout setting.

Subject to differing color capabilities of the various devices, the colors you see in the chart window are the
colors that will be used if you copy a picture to the Clipboard, save in picture format or print the chart.

See Also:
Outlining
Border Layout command



 Edit menu commands

The Edit menu offers the following commands:

Undo Undo the last insertion or deletion.
Cut Deletes boxes from the chart and moves them to the clipboard.
Copy Copies boxes from the chart to the clipboard.
Paste Below Pastes boxes from the clipboard into the chart below the Current Box.
Paste Left Pastes boxes from the clipboard into the chart to the left of the 

Current Box.
Paste Right Pastes boxes from the clipboard into the chart to the right of the 

Current Box.
Insert Above Insert a new box above the Current Box.
Insert Below Insert a new box below the Current Box.
Insert Left Insert a new box to the left of the Current Box.
Insert Right Insert a new box to the right of the Current Box.
Box Text Edit the text within the Current Box.
Mark Boxes Change the markers of the selected boxes.
Delete Delete selected boxes.
Swap Swaps the positions of two boxes.
Select All Selects all boxes.
Select Sub-Tree Selects the Current Box and all boxes below it.
Select Level Selects all boxes at the same level as the Current Box.
Select 
Subordinates

Selects all boxes immediately below the Current Box.

Select Marked Selects boxes dependent on their marker settings.
Clear Selections De-selects all selected boxes.



 Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the command 
changes, depending on what the last action was.

You can only undo box insertions and box deletions.

The Undo command is disabled if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or ALT+BACKSPACE



 Cut command (Edit menu)

Use this command to remove the currently selected boxes from the chart and put them on 
the clipboard.    If no boxes are selected, the Current Box is cut.

Cutting data to the clipboard replaces the contents previously stored there.

If you make a mistake, you can undo the box deletion caused by this command.

Shortcuts

Toolbar:
Keys: CTRL+X or SHIFT+DEL

See Also
Exchanging information between charts
Exchanging information with other programs
Selecting Boxes
Undo command



 Copy command (Edit menu)

Use this command to copy selected boxes onto the clipboard.    If no boxes are selected, the 
Current Box is copied.

Copying data to the clipboard replaces the contents previously stored there.

TreeChart can optionally also copy box text or a picture to the clipboard.

Shortcuts

Toolbar:
Keys: CTRL+C or CTRL+INS

See Also
Copying text from TreeChart into another program
Copying pictures from TreeChart into another program
Exchanging information between charts
Preferences dialog
Selecting Boxes



 Paste Below command (Edit menu)

Use this command to insert a copy of the clipboard contents below the Current Box.

If you Paste below a box that has subordinates, all those subordinates are 'demoted' and 
become
subordinates of the pasted box. In Organization Chart terms, pasting a box below a manager
creates a new middle manager position.

If you make a mistake, you can undo this command.

This command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V or SHIFT+INS

See Also
Exchanging information between charts
Pasting text from another program into TreeChart
Undo command



 Paste Left command (Edit menu)

Use this command to insert a copy of the clipboard contents to the left of the Current Box.

If you make a mistake, you can undo this command.

This command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+L

See Also
Exchanging information between charts
Pasting text from another program into TreeChart
Undo command



 Paste Right command (Edit menu)

Use this command to insert a copy of the clipboard contents to the right of the Current Box.

If you make a mistake, you can undo this command.

This command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+R

See Also
Exchanging information between charts
Pasting text from another program into TreeChart
Undo command



 Insert Above command (Edit menu)

Use this command to create a new box, placing it immediately above the Current Box.

The Current Box and all boxes below it will be moved down one level.

If you make a mistake, you can undo this command.

Shortcuts
Mouse: drag up from Current Box
Keys: ALT+UP

See Also
Initial and Default Layouts
Inserting boxes
Undo command



 Insert Below command (Edit menu)

Use this command to create a new box, placing it immediately below the Current Box.

If you insert a new box below a box that has subordinates, all those subordinates are 
'demoted' and become subordinates of the newly-inserted box. In Organization Chart terms, 
inserting a box below a manager creates a new middle manager position.

If you make a mistake, you can undo this command.

Shortcuts
Mouse: drag down from Current Box
Keys: ALT+DOWN

See Also
Initial and Default Layouts
Inserting boxes
Undo command



 Insert Left command (Edit menu)

Use this command to create a new box, placing it immediately to the left of the Current Box.

If you make a mistake, you can undo this command.

Shortcuts
Mouse: drag left from Current Box
Keys: ALT+LEFT

See Also
Initial and Default Layouts
Inserting boxes
Undo command



 Insert Right command (Edit menu)

Use this command to create a new box, placing it immediately to the right of the Current 
Box. 

If you make a mistake, you can undo this command.

Shortcuts
Mouse: drag right from Current Box
Keys: ALT+RIGHT

See Also
Initial and Default Layouts
Inserting boxes
Undo command



 Box Text command (Edit menu)

Use this command to edit the text in the Current Box.

Shortcuts
Mouse: double click on box
Keys: ENTER

See Also
Edit Text dialog box



 Delete Boxes command (Edit menu)

Use this command to delete the selected boxes. If no boxes are selected, the Current Box is 
deleted.

If you delete a box that has subordinates, but don't delete the subordinates themselves, the 
subordinates are 'promoted'.

If you make a mistake, you can undo this command.

Shortcuts
Keys: DEL

See Also
Selecting Boxes
Undo command



 Swap Positions command (Edit menu)

Use this command to swap the positions of two sub-trees.

This command is only available if two boxes are selected, and they have the same parent.

Shortcuts
Keys: CTRL+W

See Also
Selecting Boxes



 Select All command (Edit menu)

Use this command to select all boxes in the Current View.

Shortcuts

Toolbar:
Keys: CTRL+A

See Also
Selecting Boxes



 Select Sub-Tree command (Edit menu)

Use this command to select the Current Box, and all visible boxes below it.

Shortcuts

Toolbar:
Keys: CTRL+T

See Also
Selecting Boxes



 Select Level command (Edit menu)

Use this command to select all visible boxes at the same level as the Current Box.

Shortcuts

Toolbar:
Keys: CTRL+H

See Also
Selecting Boxes



 Select Subordinates command (Edit menu)

Use this command to select all boxes immediately below the Current Box.

Shortcuts

Toolbar:
Keys: CTRL+I

See Also
Selecting Boxes



 Clear Selections command (Edit menu)

Use this command to de-select all selected boxes.

Shortcuts
Mouse: click on chart when not over a box
Keys: CTRL+G

See Also
Selecting Boxes



 Edit Text / Edit Border Text dialog boxes

Text Fields, and their associated text are presented as a table. The number of fields, and 
their names, will depend on what fields you have defined for the boxes or the Border of your 
chart.

Only the associated text can be changed, not the field names or the number of fields. To 
add, delete or rename text fields, use the Define Fields or Define Border Fields command.

Movement around the table is similar to a spreadsheet. Note that the TAB key circulates the 
focus between the table, the OK button and the Cancel button. To move around the table, 
use the arrow keys (or, with the mouse, click on a cell).

Individual table cells act like normal single line edit controls. One consequence of this is that 
you can only copy and paste individual Fields (not a group of Fields).

To Press

Copy selected text CTRL+C
Cut selected text CTRL+X
Paste text CTRL+V

Pasting text from other programs can result in TAB characters being placed in your text. 
These are shown in this dialog as a vertical bar, indicating a non-displayable character. 
When you complete the dialog, TreeChart converts each TAB to a single space.

See Also
Define Fields command
Define Border Fields command



 Selecting Boxes

Some TreeChart commands (for example, edit text) can only meaningfully operate on one 
box at a time. These commands always work on the Current Box.

Other TreeChart commands (for example, delete boxes) can work on a set of boxes 
simultaneously. These commands will work on the selected boxes, or if no boxes are selected
the Current Box.

Selected boxes are shown on the display by being drawn inverted; white boxes becoming 
black, for instance.

There are four basic methods of selecting boxes:

Individually

By region

By position

Depending on their marker settings

By combining these techniques, an arbitrary set of selected boxes can quickly be defined.

Selecting Individual boxes

To toggle the selection status of the Current Box

Mouse Keyboard

Move the cursor over the box. Press SPACE
Click the left mouse button
while holding down CTRL

This is just like performing multiple selections in a list box (for example, selecting a group of 
files in Windows File Manager).

Selecting a group of boxes by region

This can only be done with a mouse. If you press (and hold down) the left mouse button 
while not
over a box, then start to drag, a dotted rectangle will be drawn to indicate the selection 
region.
Releasing the mouse button completes the operation. All boxes entirely within the selection 
region will be selected. If you move the mouse cursor outside of you chart window during 
this operation, the window automatically scrolls.

The first box in the selection region becomes the Current Box.

If you hold down CTRL as you commence the selection, current selections are retained, and 
boxes within the selection region are added to the set of selected boxes. If you do not hold 
down CTRL, current selections are cleared before selecting the boxes within the selection 



region.

Selecting a group of boxes by position.

Four menu / toolbar commands let you select a group of boxes:

Toolba
r

Edit Menu

Select All Select all boxes.

Select Level Select all boxes at the same level as the Current 
Box.

Select Subord Select all boxes directly below the Current Box.

Select Sub-
Tree

Select Current Box, and all boxes below it.

These commands always add more selections. To remove any existing selections before 
selecting a new group,    use the Clear Selections command.

Selecting a group of boxes depending on their marker settings

TreeChart allows you to mark boxes as exceptions to the rules. With the Select Marked 
command, you can select boxes depending on their marker settings.

See Also
Clear Selections command
Keys for selecting boxes
Marking Boxes as exceptions to the rules
Select Marked command



 Moving around a chart

Working with chart windows is much like working with a document window in any Windows 
application.

The caret indicates the Current Box.

Moving the caret is much like the Insertion Point in a word processor:

With a mouse: click on a box.

Keyboard: See Keys for moving the caret.

If you are using a mouse, a number of operations automatically make the box you're 
pointing at the Current Box as part of the operation.

If the Current Box is changed, the chart window is automatically scrolled to make the Current
Box visible.

See also Keys for scrolling a chart window for a summary of keyboard shortcuts for scrolling 
a chart window without moving the caret.



 Exchanging information between charts

When TreeChart copies (or cuts) boxes to the Clipboard, the information it saves in the 
Clipboard includes the name of the Layout used by each box, but not the actual Layout 
settings.

It works this way because its the most natural: if a number of boxes use the same Layout, 
pasted boxes will use exactly the same Layouts as they used before they were cut. If you 
happen to change the Layout settings after the cut command, but before the paste 
command, the pasted boxes will automatically use the new Layout settings (not the ones in 
force when the cut command was performed).

If you copy boxes from one chart to another, the Layouts used by these boxes might not be 
defined in the chart they're being pasted into. Alternatively, they might be defined, but with 
totally different settings.

What TreeChart does when pasting boxes is this: if a box uses a Layout whose name is 
defined in this chart, the box will use that Layout, otherwise it will use the Default Layout for
the level it has been inserted at.

This means that if you copy boxes from one chart to another, the pasted boxes will have the 
style / appearance appropriate for the chart being pasted into rather than the chart they 
were copied from.

At present, TreeChart offers no means to copy Layouts between charts.



 Definitions

Border
Box
Caret
Clipboard
Current Box
Current View
Default Layout
Layout
Level
Template File
Text Field



Clipboard

A temporary storage area for cut or copied information. You can paste the contents of the 
Clipboard into another chart or into a document in another Windows application.



Caret

In a word processor, the current position for text entry is indicated by a caret. With graphical
information, a simple caret isn't quite sufficient. In TreeChart, the caret is a thin red line 
which
surrounds a box. The surrounded box is called the Current Box. You move the caret to choose
a different Current Box.



Box

A box is TreeChart's term for a record in a hierarchically structured database.

Like a database record, the text that appears within a box is divided into fields. Like a 
database, all boxes have the same number of fields. When creating a chart you decide how 
many fields you need. You don't have to get this perfect before starting a chart: you can add 
or delete fields at any time.

Having constructed a hierarchy of boxes, the way the information is illustrated is determined
by the Layout settings you choose.



Current Box

In a word processor, the current position for text entry is indicated by a caret. With graphical
information, a simple caret isn't quite sufficient. In TreeChart, the caret is a thin red line 
which
surrounds a box. The surrounded box is called the Current Box.

Any command that can only operate on one box is always performed on the Current Box. 
Any
command that could operate on a number of boxes simultaneously is performed on the 
selected boxes, or if no boxes are selected, the Current Box.



Layout

A style guide; it determines how boxes appear, and how they are connected to their 
subordinates.

Layouts are similar to Style Guides found in more sophisticated word processors, and can 
greatly
assist you in achieving a consistent appearance to your charts. Once you've defined a 
Layout, you can use it as often as you like.

You can define any number of Layouts. Each must be assigned a unique name so that it can 
be referred to while preparing the chart. Every box in a chart uses one of the Layouts you 
have defined. When you change the settings of a Layout, it automatically affects every box 
using that Layout.



Border

When your chart is to be presented, a Border is added. The Border acts as a frame around 
your chart, and can add titles, headers, footers or any other text fields that you need. The 
Border frames your chart not only when printing, but also when copying the chart to the 
Clipboard as a picture, and when saving a file in picture format.

Like a box, the Border can have any number of Text Fields, and it uses a Layout. The Text 
Fields defined for the Border are different from those defined for boxes.



Default Layout

The Layout a newly-inserted box can initially use. You can define a different Default Layout 
for each level in your chart.



Text Field

Text associated with a box is stored as fields. Each field has a name. All boxes within a chart 
have the same number of fields though whether a particular field is displayed for a particular
box is defined by the Layout the box is using, as is its style (font, size, color) and the relative
order and position of fields.

TreeChart defaults to defining two box fields: Name and Position.

You can add, delete or rename fields at any time. You can also change the defaults by using 
a Template File.



Template File

A Template File is simply a chart that acts as a starting point when you create a new chart. A
Template contains:

A definition of which text fields are available

A set of Layouts

Other chart settings

Template Files are normally given a filename extension of .TCT.

TreeChart only recognizes one Template File at a time, but you can switch Templates to any
TreeChart-format file whenever you wish.

The Template File is also used if you open a text-format file. This can greatly reduce the time
to
prepare a chart when importing text from other programs.



Level

The rank of a box within the hierarchy. The box at the top of the hierarchy is at level 1; 
subordinates to this box are at level 2, and so on.

Level numbers are not affected by any outlining selections you make: if a box is at level 5 in 
the full chart, it is also at level 5 if you Focus on it to make it the top-most visible box.

When you insert a new box, the Layout it initially uses can be defined by the Default Layout 
for the level it has been inserted at.

You can select all boxes at a certain level, and match box sizes within levels.



Current View

The outlining selections you make define the Current View of the chart.

Wherever sensible, commands you select are always performed on the Current View. For 
example, the Select All command selects all boxes in the Current View.

The only operations that are always performed on the whole chart, rather than the Current 
View are:

Saving the chart (in TreeChart format or Text format)

Adding, deleting or renaming a box Text Field

Working with the Current View rather than the whole chart is particularly useful when you 
need to output the finished chart: if you print, copy a picture to the Clipboard or save a 
picture-format file, it is always the Current View.



 Keyboard shortcuts

You can use keyboard shortcuts for commands and actions. Each shortcut key consists of a 
letter, symbol or function key, often pressed in combination with the CTRL, SHIFT and ALT keys. 
Choose any of the topics from the following list of categories to see which key combinations 
can be used to speed up common operations.

See also
Keys to Get Help
Keys for moving the caret
Keys for scrolling a chart window
Keys for selecting boxes
Keys for adding, removing and re-arranging boxes
Keys for changing box text
Keys for editing the Layout used by the Current Box
Keys for changing which Layout is used by selected boxes
Keys for marking boxes as exceptions to the rule
Keys for changing the Border
Keys for hiding boxes (outlining)
Keys for changing the scale at which a chart is displayed
Keys for managing the TreeChart application window
Keys for managing chart windows
Keys for choosing menus and commands
Keys for working with dialog boxes
Keys to access Toolbar buttons



 Keys to Get Help

Use the following keyboard shortcuts to get help on working with TreeChart. TreeChart uses 
the standard Windows Help facility.

To Press

Get Help (context dependent) F1

Enter Help mode SHIFT+F1

Leave Help mode without getting Help ESC

See Help contents CTRL+F1



 Keys for moving the caret

Use the following keyboard shortcuts to move the caret.

Moving the caret changes which box is the Current Box. If the new Current Box is not fully 
on-screen, the chart window is automatically scrolled to make it visible.

Note that all keys for moving the caret require Scroll Lock mode to be off. If Scroll Lock is on, 
these keys scroll the chart window without moving the caret.

The state of Scroll Lock mode is indicated on the TreeChart Status Bar.
To move the Insertion Point Press

One box left LEFT ARROW

One box right RIGHT ARROW

One box up UP ARROW

One box down DOWN ARROW

To the top-left box HOME

To the bottom-right box END



 Keys for scrolling a chart window

Use the following keyboard shortcuts to scroll a chart window without moving the caret.

Scrolling the window 'a little' means 20% of the window; scrolling 'a lot' means 90% of the 
window.

Note that many keys for scrolling the chart window without moving the caret require Scroll 
Lock mode to be on. These keys are marked (SCRL). If Scroll Lock is off, these keys move the 
caret; the chart window may then scroll automatically to ensure the Current Box is visible.

The state of Scroll Lock mode is indicated on the TreeChart Status Bar.

To scroll the chart window Press

Left a little (SCRL) LEFT ARROW

Left a lot CTRL+PAGE UP

Right a little (SCRL) RIGHT ARROW

Right a lot CTRL+PAGE DOWN

Up a little (SCRL) UP ARROW

Up a lot PAGE UP

Down a little (SCRL) DOWN ARROW

Down a lot PAGE DOWN

To the top-left of the chart (SCRL) HOME

To the left edge of the chart (SCRL) CTRL+HOME

To the bottom-right of the chart (SCRL) END

To the right edge of the chart (SCRL) CTRL+END



 Keys for selecting boxes

Use the following keyboard shortcuts to select boxes.

Any TreeChart command that can only apply to on one box always applies to the Current 
Box. Any command that can apply to more than one box always applies to the selected 
boxes, or if no boxes are selected then the Current Box.

To Press

Toggle the selection status of the Current Box SPACE

Select all boxes CTRL+A

Select the Current Box and all boxes below it CTRL+T

Select all boxes at the same level as the Current Box CTRL+H

Select all boxes immediately below the Current Box CTRL+I

Select all boxes with subordinates CTRL+1

Select all boxes without subordinates CTRL+2

De-select all selected boxes CTRL+G



 Keys for adding, removing and re-arranging boxes

Use the following keyboard shortcuts to insert, delete, cut and paste boxes.
To Press

Insert a box in an empty chart or view ALT+any arrow key

Insert a new box above the Current Box ALT+UP

Insert a new box below the Current Box ALT+DOWN

Insert a new box to the left of the Current Box ALT+LEFT

Insert a new box to the right of the Current Box ALT+RIGHT

Paste Clipboard contents below the Current Box CTRL+V

Paste Clipboard contents left of the Current Box CTRL+L

Paste Clipboard contents right of the Current Box CTRL+R

Swap two selected boxes CTRL+W

Undo last box insertion or box deletion CTRL+Z

The following commands apply to the selected boxes, or if no boxes are selected then the 
Current Box:

To Press

Delete boxes DEL

Copy boxes to Clipboard CTRL+C

Cut boxes to Clipboard CTRL+X



 Keys for changing box text

Use the following keyboard shortcuts to define the Text Fields in boxes and edit each box's 
text.

To Press

Define the Text Fields F3

Edit Text Fields of the Current Box ENTER

In the Edit Text Fields dialog box:
Move between Text Fields UP or DOWN

Move between text table, OK and Cancel buttons TAB

Extend selection in a text field SHIFT+ARROW key

Extend selection to first character in text field SHIFT+HOME

Extend selection to last character in a text field SHIFT+END

Copy selected text to Clipboard CTRL+C

Cut selected text to Clipboard CTRL+X

Paste text from Clipboard CTRL+V



 Keys for editing the Layout used by the Current Box
Use the following keyboard shortcuts to edit the Layout used by the Current Box.

Note that other boxes may also be using the Layout used by the Current Box. Changing a 
Layout's settings will automatically affect all boxes using that Layout.

To change Press

Size settings F8

Spacing settings SHIFT+F8

All other Layout settings SHIFT+ENTER

Text styles CTRL+Y

The Text Styles command allows you to make a series of changes to the text styles of any 
group of fields within any group of Layouts.



 Keys for changing which Layout is used by selected boxes
Use the following keyboard shortcuts to change which Layout boxes use.

The following commands apply to the selected boxes, or if no boxes are selected then the 
Current Box:

To Press

Choose a Layout from a list of those available CTRL+D to show the Define Layouts dialog

Use the Default Layout for the level each box is at CTRL+U



 Keys for changing the Border
Use the following keyboard shortcuts to define Border Text Fields, and change the text, 
appearance and margins of the Border.

To Press

Define the Border Text Fields SHIFT+F3

Edit the Border Text Fields F7

Change the Border Layout SHIFT+F7

Change the Border Margins CTRL+F7

In the Edit Border Text Fields dialog box:

Move between Text Fields UP or DOWN

Move between text table, OK and Cancel buttons TAB

Extend selection in a text field SHIFT+ARROW key

Extend selection to first character in text field SHIFT+HOME

Extend selection to last character in a text field SHIFT+END

Copy selected text to Clipboard CTRL+C

Cut selected text to Clipboard CTRL+X

Paste text from Clipboard CTRL+V



 Keys for hiding boxes (outlining)
Use the following keyboard shortcuts to focus on one sub-tree of the chart, or collapse boxes
to hide boxes below them.

To Press

View the whole chart CTRL+Q

Focus on Current Box or chart root CTRL+F

Collapse selected boxes CTRL+K

Expand selected boxes CTRL+E

Expand all collapsed boxes CTRL+SHIFT+E



 Keys for changing the scale at which a chart is displayed
Use the following keyboard shortcuts to change the zoom factor, which determines the scale
at which a chart is displayed.

To Press

Zoom In +

Zoom Out -

Restore normal (100%) zoom =

Set a specific zoom factor F2 to open Toolbar list,
then UP and DOWN to change,
then ENTER



 Keys for managing the TreeChart application window
Use the following keyboard shortcuts to control the TreeChart application window and switch 
between applications.

To Press

Open the TreeChart application control menu ALT+SPACEBAR

Quit TreeChart ALT+F4

Switch to next application window or icon ALT+ESC

Switch to next application, restoring if minimised ALT+TAB

Move the TreeChart application window ALT+SPACEBAR to open the Control menu
ARROW keys to move the window
ENTER to complete the move

Change the TreeChart application window size ALT+SPACEBAR to open the Control menu
ARROW key to pick up a window edge
ARROW keys to move the window edge
ENTER to complete the re-size



Keys for managing chart windows
Use the following keyboard shortcuts to control a chart window and switch between chart 
windows.

To Press

Open the active chart's Control menu ALT+HYPHEN

Close the active chart window CTRL+F4

Switch to next chart window CTRL+F6

Switch to previous chart window CTRL+SHIFT+F6

Restore minimised chart window to previous size ENTER

Move the active chart window ALT+HYPHEN to open the Control menu
ARROW keys to move the window
ENTER to complete the move

Change the active chart window size ALT+HYPHEN to open the Control menu
ARROW key to pick up a window edge
ARROW keys to move the window edge
ENTER to complete the re-size



 Keys for choosing menus and commands
Use the following keyboard shortcuts to choose menus or commands.

To Press

Get Help F1

Activate the menu bar F10

Choose the TreeChart window control menu ALT+SPACEBAR

Choose the chart window control menu ALT+HYPHEN

Close any open menu ESC

Close a chart window CTRL+F4

Choose the File menu ALT+F

Choose the Edit menu ALT+E

Choose the View menu ALT+V

Choose the Layout menu ALT+L

Choose the Chart menu ALT+C

Choose the Window menu ALT+W

Choose the Help menu ALT+H

Open a new chart CTRL+N

Open an existing chart CTRL+O

Save the active chart CTRL+S

Print the active chart CTRL+P

Show or hide the Toolbar SHIFT+F2

Show or hide the Status Bar CTRL+F2



 Keys for working with dialog boxes
Use the following keyboard shortcuts to move between controls in a dialog box, and select 
options.

To Press

Cancel the dialog ESC

Move between controls or groups TAB

Move between controls or groups (reverse order) SHIFT+TAB

Move directly to control or group ALT+underlined letter

Move between options within a group ARROW key

Execute a command button ENTER

Open a drop-down list box ALT+DOWN

Select item in a drop-down list box ALT+UP or ALT+DOWN

Select or clear a checkbox SPACEBAR

Extend selection in a text box SHIFT+ARROW key

Extend selection to first character in text box SHIFT+HOME

Extend selection to last character in a text box SHIFT+END

Select next list-item beginning with a character character key

Extended-selection list boxes:

Select or cancel selection of item SHIFT+ARROW key

Select all items CTRL+SLASH (/)

Cancel all selections except the current selection CTRL+BACKSLASH (\)

Extend selection SHIFT+ARROW key

Extend selection to first item SHIFT+HOME

Extend selection to last item SHIFT+END

Select non-consecutive items SHIFT+F8 to begin 'add mode' (cursor blinks)
ARROW keys move between items
SPACEBAR to select or cancel selection of item
SHIFT+F8 to finish 'add mode' (cursor normal)



 Keys to access Toolbar buttons

Use the following keyboard shortcuts to access buttons on the Toolbar. These keys can be 
used even if the Toolbar is not displayed.

To access the Press

New button CTRL+N

Open button CTRL+O

Save button CTRL+S

Cut button CTRL+X

Copy button CTRL+C

Paste Below button CTRL+V

Select All button CTRL+A

Select Sub-Tree button CTRL+T

Select Level button CTRL+H

Select Subordinates button CTRL+I

Mark Boxes button CTRL+M

Text Styles button CTRL+Y

Define Layouts button CTRL+D

View All button CTRL+Q

Focus button CTRL+F

Collapse button CTRL+K

Expand button CTRL+E

Expand All button CTRL+SHIFT+E

Print button CTRL+P

Print Preview button
Help Mode button SHIFT+F1

Zoom: open list F2

Zoom: change list selection UP or DOWN ARROW

Zoom: close list ENTER



 Keys for marking boxes as exceptions to the rules
Use the following keyboard shortcuts to change the markers of the selected boxes, or if no 
boxes are selected, the Current Box

To Press

Show the Mark Boxes dialog box CTRL+M

Set the Invisible marker F9

Clear the Invisible marker SHIFT+F9

Set the Disconnect from Parent marker CTRL+F9

Clear the disconnect from Parent marker CTRL+SHIFT+F9

Set the Co-Manage Left marker F10

Clear the Co-Manage Left marker SHIFT+F10

Set the Co-Manage Right marker CTRL+F10

Clear the Co-Manage Right marker CTRL+SHIFT+F10

Set the Co-Manage Group marker F11

Clear the Co-Manage Group marker SHIFT+F11

Set the Assistant marker (placing Right) F12

Set the Assistant marker (placing Left) CTRL+F12

Clear the Assistant marker SHIFT+F12

Note that the F11 key also sets/clears the Invisible and Disconnect from Parent markers.



 Marking Boxes as Exceptions to the Rules

TreeChart minimizes the amount of work you have to do by making two assumptions:

That all subordinates to a box are positioned and connected uniformly.

That each box in the hierarchy has only one parent.

Most of the time you'll appreciate the benefits of these assumptions, but occasionally you'll 
find it useful to be able to mark some boxes as exceptions to the rules.

You can think of boxes as having a set of flags associated with them. Each flag indicates a 
particular exception condition, and you can set a flag to mark a box as an exception to the 
rule. By default, all the flags are cleared. The flags are independent, and can be used in any 
combination.

When you save your chart the flags are saved too. If you copy and paste boxes, the flags are
copied along with the box text.

You can set or clear individual marker flags.

You can select boxes depending on the state of marker flags.

For the meaning of the individual markers, see:
Assistant
Co-Manage Group
Co-Manage Left
Co-Manage Right
Disconnect from Parent
Ignore when matching Heights/Widths
Invisible

See Also
Selecting Boxes
Mark Boxes command
Select Marked command
Keys for marking boxes as exceptions to the rules



 Mark Boxes command (Edit menu)

Boxes can be marked as exceptions to the normal Layout rules.

Use this command to change the markers of the selected boxes, or the Current Box if no 
boxes are selected.

Shortcuts

Toolbar:
Keys: CTRL+M

See Also
Selecting Boxes
Marking Boxes as Exceptions to the Rules
Mark Boxes dialog box 
Keys for marking boxes as exceptions to the rules



 Select Marked command (Edit menu)

Boxes can be marked as exceptions to the Layout rules.

Use this command to select boxes based on their marker settings.

See Also
Marking Boxes as Exceptions to the Rules
Select Marked Boxes dialog box
Keys for marking boxes as exceptions to the rules



 Box Marker: Invisible

Boxes marked in this way are simply not drawn, but their connectors are.

The overall effect is that subordinates of an invisible box are positioned one level lower in 
the hierarchy than would normally be the case. For example, here there is an Invisible box 
between the Director and the Researcher.

If you enter text in a box marked as Invisible, the text is drawn and obscures the connecting 
lines. This can be useful to annotate lines.

Shortcuts
Key to Set: F9
Key to Clear: SHIFT+F9

Note that this marker is also changed by the shortcut keys associated with the Co-Manage 
Group marker.



 Box Marker: Disconnect from Parent

Boxes marked in this way are simply 'disconnected' from their parent by omitting their 
connecting lines.

For Example:

Any part of the connector which is drawn purely to attach a disconnected box is omitted. If 
all subordinates are marked as disconnected, any common part of the connector is also 
omitted. If you do want to omit all connecting lines, its often easier to define and use a new 
Layout, specifying a connector line width of '(none)'.

Shortcuts
Key to Set: CTRL+F9
Key to Clear: CTRL+SHIFT+F9

Note that this marker is also changed by the shortcut keys associated with the Co-Manage 
Group marker.    



 Box Marker: Co-Manage Left

Boxes marked in this way have an additional connecting line drawn automatically: direct 
from the center of the marked box to the center of the 'nearest' subordinate of the box to 
the left on the same sub-tree.

For example:

This exception is useful for illustrating dual-reporting structures.

The additional line is normally drawn in the same style as the connections from the marked 
box to its subordinates. Select the Co-Manager Links as Dotted Lines marker to instead 
draw a thin dotted line.

Shortcuts
Key to Set: F10
Key to Clear: SHIFT+F10



 Box Marker: Co-Manage Right

Boxes marked in this way have an additional connecting line drawn automatically: direct 
from the center of the marked box to the center of the 'nearest' subordinate of the box to 
the right on the same sub-tree.

For example:

This exception is useful for illustrating dual-reporting structures.

The additional line is normally drawn in the same style as the connections from the marked 
box to its subordinates. Select the Co-Manager Links as Dotted Lines marker to instead 
draw a thin dotted line.

Shortcuts
Key to Set: CTRL+F10
Key to Clear: CTRL+SHIFT+F10



 Box Marker: Co-Manage Group

Boxes marked in this way are disconnected from their subordinates, and those subordinates 
are instead connected to the boxes to the left & right of the marked box (on the same sub-
tree).

For example:

This is useful in illustrating some situations involving a dual reporting structure. The marked 
box is effectively a placeholder    grouping a department actually managed by the boxes to 
its left & right.

The marked (placeholder) box is often also marked as Invisible and Disconnect from Parent. 
The shortcut key also changes these markers.

The additional lines are normally drawn in the same style as the connections from the 
marked box to its subordinates. Select the Co-Manager Links as Dotted Lines marker to 
instead draw thin dotted lines.

Shortcuts
Key to Set: F11
Key to Clear: SHIFT+F11



 Mark Boxes dialog box

The Mark Boxes dialog box allows you to change the individual markers for the selected 
boxes. If no boxes are selected, the markers of the Current Box are changed.

When the dialog box is initially shown:

A checkbox will be checked if the corresponding flag is set in every selected box.

A checkbox will be blank if the corresponding flag was clear in every selected box.

A checkbox will be grayed if the corresponding flag is different in the selected boxes.

If you choose the OK button, the dialog box is completed, and the flags in the selected boxes
are changed:

Where a checkbox is checked, the corresponding flag will be set in every selected 
box.

Where a checkbox is blank, the corresponding flag will be cleared in every selected 
box.

Where a checkbox is gray, the corresponding flag will remain unchanged.

If you choose the Cancel button, the dialog box is removed without changing any flags.

For the meaning of the individual markers, see:
Assistant
Co-Manage Group
Co-Manage Left
Co-Manage Right
Disconnect from Parent
Ignore when matching Heights/Widths
Invisible

See Also
Marking Boxes as Exceptions to the Rules
Keys for marking boxes as exceptions to the rules
Keys for working with dialog boxes



 Select Marked Boxes dialog box

The Select Marked Boxes dialog box allows you to select boxes depending on their marker 
settings.

Each individual flag has its own checkbox. The checkboxes are three-state, which means 
they can be "don't care" as well as the normal on and off. The "don't care" state is indicated 
by a gray pattern. Clicking on a checkbox cycles through the three states.

When the dialog box is initially shown, all checkboxes are grayed.

Use the checkboxes to specify a search pattern. Checkboxes that are not grayed mean that 
the associated flag must be in the state (on or off) that you have chosen.

For example:

To select all boxes that with the Co-Manage Left marker set, and the Invisible marker set, 
and the Disconnect from Parent marker clear:

Co-Manage Left checkbox checked
Invisible checkbox checked
Disconnect from Parent checkbox clear

When you choose the OK button, all boxes matching the search pattern are selected.

If you choose the Cancel button, the dialog box is removed without changing the current 
selections.

For the meaning of the individual markers, see:
Assistant
Co-Manage Group
Co-Manage Left
Co-Manage Right
Disconnect from Parent
Ignore when matching Heights/Widths
Invisible

See Also
Selecting Boxes
Marking Boxes as Exceptions to the Rules
Keys for marking boxes as exceptions to the rules
Keys for working with dialog boxes



 Box Marker: Assistant

Boxes marked in this way are regarded as Assistants when subordinate to another box. This 
means that they are positioned and connected differently to the other subordinates. For 
example:

This is useful in illustrating the common requirement when preparing an Organization Chart 
to indicate that this subordinate is actually an assistant, a secretary or has a similar 
relationship to a manager.

Assistants are normally positioned to the right of the vertical line. Select the Place Left 
marker to position the Assistant to the left of the vertical line.

Shortcuts
Key to Set, placing Right: F12
Key to Set, placing Left: CTRL+F12
Key to Clear: SHIFT+F12



 Box Marker: Ignore when matching Heights / Widths

These two markers enable you to fine-tune the automatic matching of box sizes.

You can tell TreeChart to make all boxes (within various categories) the same size. All the 
boxes would then be enlarged to match the largest box.

These markers allow you either to ignore a particularly large box (and make all other boxes 
the same size as the second largest box), or to prevent a particularly small box from being 
enlarged.

See Also
Match Box Sizes command



 The steps involved in preparing charts
At its simplest, preparing a chart is a five step process:

Define a hierarchy of boxes.

Enter the text for each box.

Specify how the chart should look.

Add any titles and a border.

Print the chart.

Naturally, TreeChart lets you jump back and forth between these steps so you can try out your ideas 
before committing the chart to paper.

See Also
Working in a chart window
Inserting boxes
Edit Text command
Boxes and Layouts
Adding Titles and a Border
Printing charts



 Printing charts
TreeChart always prints the Current View - that is, any outlining selections are applied to the printed 
chart as well as the chart displayed on the screen. What you see on the screen is what will be printed. To 
print the whole chart, you must view the whole chart.

When you print a chart, it is framed by its Border.

The advantage of printing the Current View, rather than the whole chart, is that it allows you to print a 
chart as a series of pages. With an organization chart, for example, you could print top-level management
on one page, then each department on further pages. Each page would have its own Border and titles.

How the chart gets printed is determined by a series of factors:

Position the Border on the page, leaving an area available for the chart

Match the chart to the available area

Position the chart within the available area

Add any titles and a border.

Print the chart plus Border

Positioning the Border on the Page

The paper size is determined by the selected printer, and the paper source and orientation. 
The Page Margins specify the distance between the edge of the paper and the border 
rectangle (fig 1).

fig 1 fig 2 fig 3

The Border Margins (plus text styles and position) specify where Border text is placed 
relative to the border rectangle (fig 2).

Most printers have small non-printable regions near the edges of the page. If any Border 
elements extend into the non-printable area, the Border position is automatically adjusted to
prevent incomplete printing.

The remaining Border Margins specify a minimum distance between border elements and 
the chart. This defines the area available for the chart (fig 3).

Matching the chart to the available area

If the chart is larger than the available area, either the chart is reduced to fit the available 
area, or the available area is enlarged to accommodate the chart.

If the Print Style is Fit-to-Page, the chart is proportionately reduced.



If the Print Style is Poster, additional pages are added to make the available area larger 
than the chart. The Border will remain at the same distance from the paper edge, but will 
only appear on 'outer' sheets of paper. For example:

To change the Print Style, use the Page Setup command.

Positioning the chart within the available area

The Chart Alignment selection in the Page Setup dialog determines where the chart is 
positioned within the available area.

See Also
Page Setup command
Border Margins command
Border Layout command
Outlining
Adding Titles and a Border
Print command
Print Preview command
Print Setup command
Printing hints & tips



Boxes and Layouts

A box is TreeChart's term for a record in a hierarchically structured database.

Like a database record, the text that appears within a box is divided into fields. Like a 
database, all boxes have the same number of fields. When creating a chart you decide how 
many fields you need. You don't have to get this perfect before starting a chart: you can add 
or delete fields at any time.

Having constructed a hierarchy of boxes, the way the information is illustrated is determined
by the Layout settings you choose.

A Layout defines how a box appears in a chart, and how it is arranged with and connected to
the boxes hierarchically under it.

Layouts are similar to Style Guides found in more sophisticated word processors, and can 
greatly assist you in achieving a consistent appearance to your charts. Every box in a chart 
uses one of the Layouts you have defined. When you change the settings of a Layout, it 
automatically affects every box using that Layout. You can define any number of Layouts 
and tell a box to use a different Layout any time you like.

See Also
Inserting boxes
Working in a chart window



 Adding titles and a Border
When your chart is to be presented, a Border is added. The Border acts as a frame around your chart, 
and can add titles, headers, footers or any other text fields that you need. The Border frames your chart 
not only when printing, but also when copying the chart to the Clipboard as a picture, and when saving a 
file in picture format.

The process of deciding how the Border appears is very similar to deciding how an individual box 
appears:

Define what Border text fields you need.

Enter the Border text.

Change the Border Layout, to specify how the Border appears.

Change the Border Margins, to specify distances between the border, its text and the chart.

The similarity goes further, and in most respects the Border can be thought of as a special box into which 
your chart is placed.

See Also
Define Border Text Fields command
Border Margins command
Border Layout command
Edit Border Text command
Printing charts



 Speeding up your work with Template Files
A Template is simply a chart that acts as a starting point when you create a new chart.

A Template contains:

Definition of Text Fields

A set of Layouts

Definition of Default Layouts

Border text and Layout

Page margins and print style (poster or fit-to-page)

Overall box size-matching rules

Custom color settings

Normally, a Template would contain no boxes, though you can store boxes in a Template file 
if you wish - these boxes would then be created automatically for you when you create a 
new chart.

The file format of Templates is identical to charts, but Template files are normally given a 
filename extension of .TCT to indicate they serve a different purpose.

There are two situations where a Template is used:

When you create a new chart

When you open a text-format file

In both cases, TreeChart simply reads the Template File you have specified before allowing 
you to modify the chart or reading the text-format file.

If you change the settings of a Template File, for instance, changing some colors, this will not
affect charts previously created from this Template, only charts created after the change.

If you choose not to specify a Template File, or TreeChart is unable to read the Template File 
you have specified, TreeChart uses a built-in default Template.

To create a new Template File:

Since a Template is simply an empty chart, creating a Template is just like creating a chart, 
then deleting all the chart-specific information (ie the boxes):

1 Prepare a chart
2 Delete all the boxes



3 Save the (empty) chart with a filename extension of .TCT

For step 1, you could open an existing chart whose style you wished to use as a Template, or
open an existing Template, or create a chart from scratch.

To edit an existing Template File:

Since a Template is simply an empty chart, editing a Template is just like editing a chart, 
then deleting all the chart-specific information (ie the boxes):

1 Open the Template File
2 Temporarily insert some boxes to illustrate the changes you'll make
3 Make the desired changes
4 Delete all the temporarily inserted boxes
5 Save the Template

To specify which Template File to use for newly-created charts:

1 From the File menu, choose Preferences
2 In the Template control, select the file to be used as the Template
3 Choose the OK button

See Also
Opening a text-format file
Preferences command



Inserting new boxes
You can insert a new box above, below, to the left or to the right of an existing box. The 
existing box you'd like the new box to connect to must first be made the Current Box.

Box insertion works in terms of the hierarchy rather than where boxes are drawn. For 
example, to add a co-worker under the same manager, you would always insert left (or 
right) of an existing box. Where the new box gets drawn in relationship to the existing box is 
a separate issue.

If you insert a new box below a box that has subordinates, all those subordinates are 
'demoted' and become subordinates of the newly-inserted box. In Organization Chart terms, 
inserting a box below a manager creates a new middle manager position.

When you insert a new box ...

its initial appearance is determined by which Layout it initially uses. You can choose 
how initial Layouts are assigned.

the caret is always moved to make the new box the Current Box. If necessary, the 
chart window is automatically scrolled to make the newly-inserted box visible.

You can choose to automatically be prompted to enter the text associated with the 
box.

If you make a mistake when inserting a box, you can undo the insertion.

Inserting a box with the mouse

With the mouse, you can insert a new box next to an existing box by simply dragging from 
the existing box.

Inserting a box with the keyboard or menus

1 Move the caret to the box you'd like to insert next to
2 From the Edit menu, choose Insert Above, Below, Left or Right

Inserting a box in an empty chart

Inserting a box in an empty chart is just like inserting subsequent boxes, except that you 
don't have to tell TreeChart which box the new box should be connected to. The keyboard 
and menu box insertion commands are unchanged.

To insert a box in an empty chart with the mouse, drag from anywhere in the chart window.

See Also
Initial and Default Layouts
Insert Above command
Insert Below command
Insert Left command



Insert Right command
Preferences command
Using a mouse in a chart window
Undo command



Initial and Default Layouts
When a new box is inserted, it automatically uses one of the Layouts you have defined. 
While you can change which Layout a box uses at any time, you can speed up your work by 
specifying how these initial Layouts should be assigned.

There are two options for the initial Layout:

Use the same Layout as the box you are inserting next to

Use the Default Layouts for the level at which the new box is inserted

To change the initial Layout option:

1 From the File menu, choose Preferences
2 In the Initial Layout radio buttons, select Level Dependent or Same as Current Box
3 Choose the OK button

The Initial Layout is a program option affecting all open charts, and is not stored with any 
chart.

Default Layouts are those chosen by you as being the most appropriate for each level in the 
hierarchy. The Default Layout for a particular level is determined as a two-step process:

If there is a specific Layout named as Default for this level, use it

If there is no specific Layout named for this level, use a chart-wide default

To Specify the Default Layout for any Level:

1 From the Layout menu, choose Defaults
2 Select    different Layouts in    the default or level-dependent drop-down lists
3 Choose the OK button

The chart-wide default can be selected from the Default drop-down list.

Defaults for specific levels can be selected from the level-specific drop-down lists. If you 
don't want to name a specific Layout as default for a level, just select '(default)' in the list.

Only eight levels can have defaults specified, any boxes inserted at levels nine and above 
will always use the chart-wide default.

Other uses of Default Layouts

While the Default Layout for a given level is only used when inserting a new box, there are 
occasions when its useful to select a group of boxes and set them to use their Default 
Layouts. One occasion is when you copy a set of boxes to the Clipboard, then paste them 
somewhere else in the chart. TreeChart preserves a reference to the Layout they were using 
and (assuming its still defined) uses that when pasting back into the chart. Sometimes, this 
might not be what you want, so in these circumstances, select the boxes that have been 



pasted, then request that they use their Default Layout.

To tell a box to use its Default Layout:

1 Select the boxes you which should use their Default Layouts
If no boxes are selected, the Current Box is used

2 From the Layout menu, choose Use Default

See Also
Default Layouts command
Inserting boxes
Preferences command
Selecting Boxes
Use Default command



 Select Boxes With Subordinates command

Use this command to select all boxes in the Current View that have boxes below them.

Boxes which have their subordinates hidden using outlining techniques are also selected.

Shortcuts
Keys: CTRL+1

See Also
Outlining
Selecting Boxes
Keys for selecting boxes



 Select Boxes Without Subordinates command

Use this command to select all boxes in the Current View that do not have boxes below 
them.

Boxes which have their subordinates hidden using outlining techniques are not selected.

Shortcuts
Keys: CTRL+2

See Also
Outlining
Selecting Boxes
Keys for selecting boxes



 Text Field Options dialog box

This dialog box allows you to choose options concerned with how the selected Text Field is 
displayed for the Layout you are editing.

Prefix and Suffix

Enter text that will precede or follow box or border text. This text is shown using the same 
font as the field itself. If you want spaces between the field and prefix or suffix, this should 
be included in the prefix or suffix.

If the field is empty for a box or the border, the prefix and suffix are normally omitted. If you 
want the prefix or suffix to be shown when the field is empty, select the appropriate 
checkbox.

Field Format

Some calculated fields can be shown in a number of different formats. If this listbox is 
enabled, choose the format you prefer.

Field width and Spacing between fields on the same line

The space needed to show each text field is the main factor in determining the size of a box.
Normally, TreeChart will make each box large enough to show whatever text is associated 
with the box, but you can control how this is done.

The width of a field can either be automatically calculated or a fixed size.

Automatic

For automatically calculated field widths, the gap between fields on the same line is 
determined by the number of spaces that follow the field.

The Max Chars control allows you to limit how much box text is displayed. Lengthy text 
fields can therefore be truncated. The limit is imposed on the actual box or border text; any 
prefix or suffix text is unaffected by this setting. See Handling Truncated Fields (below) 
for further information on truncating fields.

Manual

Manually set field widths are fixed distances. These allow you to tabulate and align groups of
fields.

Text (plus any prefix or suffix text) will be displayed within a fixed width. To control spacing 
between fields on the same line, you must also specify the distances before and after this 
fixed width.

The text can be positioned to be left-, center- or right-aligned within the fixed width you 
have selected.

If the text (plus prefix or suffix text) is too wide for the width you have specified, it will be 
truncated.



Handling Truncated Fields

Fields can be truncated if you manually set a fixed width or if you select a limit on the 
number of characters to be shown for an automatically calculated width. In both cases, the 
right-most characters are normally omitted.

Select the Truncate Start of Text checkbox if you prefer to have the left-most characters 
omitted.

Select the Indicate Truncated Text checkbox if you would like "..." to precede or follow the
text to indicate that text truncation has taken place.

See Also
Automatically Calculated Border Fields
Automatically Calculated Box Fields



 Template Settings dialog box

This dialog box allows you to choose how boxes are created when you later use this chart as 
a Template File.

When you open a text-format file, TreeChart opens the Template File you have selected then 
pastes into the chart the boxes created from the text-format file.

If the Template File contains boxes, the Current Box is remembered, and you can choose 
whether the newly-created boxes should be pasted to the left, to the right or below the 
Current Box.

If the Current Box is correct, select a direction then choose OK to save the Template File.

If the Current Box is not correct, choose Cancel, change the Current Box then repeat the 
Save operation. 

If the Template File does not contain any boxes, these settings are irrelevant and this dialog is not shown.



 Automatically Calculated Box Fields

When editing a Layout to determine which fields are shown, and their position and style, a 
number of automatically calculated fields can be shown in addition to the Box Fields that you
have defined:

<number> Boxes are numbered from top-left to bottom-right

<level> The level within the chart

<outline 
number>

Box classification code (eg 1.2.3.2)

<relative 
number>

Subordinate number; subordinates are numbered left 
to right.

Automatically calculated box fields reflect the entire chart: if you do outlining, these fields 
don't change.

For each of these fields, you can choose from a range of different formats.

Changing the field format

The field format is a Layout setting. To change the format:

1 Edit the Layout
2 Select the field
3 Choose the Options button
4 Choose from the list of available Formats

Default field formats

If the Layout format "(default)" is selected, the format defined by the program preferences is
used. Note that program preferences are not saved with charts. 

See Also
Edit Layout command
Outlining
Preferences command



 Automatically Calculated Border Fields

When editing the Border Layout to determine which fields are shown, and their position and 
style, a number of automatically calculated fields can be shown in addition to the Border 
Fields that you have defined:

<date/time> The date/time on which the chart is printed (or a picture    
is exported)

<file name> The full pathname of the chart (the chart window title is 
used if the chart hasn't been saved yet)

<file title> The chart window title

For the date / time field, you can choose from a range of different formats.

Changing the field format

The field format is a Border Layout setting. To change the format:

1 Edit the Border Layout
2 Select the field
3 Choose the Options button
4 Choose from the list of available Formats

Default field formats

If the Border Layout format "(default)" is selected, the format defined by the program 
preferences is used. Note that program preferences are not saved with charts. 

See Also
Border Layout command
Preferences command



 Text Styles command (Layout menu)

Use this command to make a series of changes to the text styles of any group of fields 
within any group of Layouts.

Shortcuts

Toolbar:
Keys: CTRL+Y

See Also
Text Styles dialog box



 Text Styles dialog box

This dialog box allows you to make a series of changes to the text style of any group of fields
within any group of Layouts.

1 Select a group of Layouts
2 Select a group of Fields

The various style controls are updated to reflect the current styles of the Fields and Layouts 
you have selected. Where controls are blank or grayed, the current styles vary.

The Increase and Decrease buttons immediately enlarge or reduce the point size of text 
within the selected Fields and Layouts, while maintaining relative differences. The chart is 
immediately re-drawn to reflect the change. To make selected fields the same point size, use
the Size control.

Font Select from the list of available fonts. TreeChart lists only those fonts that are 
available on the current printer and for screen use. Leave the selection blank 
to leave current fonts unchanged.

Size Select the point size you require. Leave the selection blank to leave current 
point sizes unchanged.

Color Select a color for the text. Leave the selection blank to leave current text 
colors unchanged.

Hide Select this checkbox to hide text fields.

Bold Select this checkbox to enable bold text.

Italic Select this checkbox to enable italic text.

Strikeout Select this checkbox to enable text strikeout.

Underline Select this checkbox to enable text underlining.

After changing style settings, choose OK to apply the changes to all selected Fields within all
selected Layouts, and complete the dialog.

Choose Apply to apply the changes but remain in the dialog. The chart is redrawn to reflect 
the changes you have made. This allows you to select different Fields or Layouts and then 
make further changes to the style settings.

Choose the Cancel button to complete the dialog without making any changes. If you Apply
a change, this cannot be undone, and the Cancel button is changed to a Close button. 
Choosing Close completes the dialog, ignoring selections made since the last Apply, 
Increase or Decrease operation.



 Printing Hints & Tips

These hints & tips include ideas for working with printers.

They also describe a few printing problems that we are aware of, and some ideas as to how 
you might overcome them.

See Also:
Connecting Lines Drawn Through Boxes
Losing Text When Poster Printing
Maximizing the area of paper used when printing
Minimum Page Margins
Omitting the Border
Print Preview Shows Text Badly
Working With a Plotter



 Working with a Plotter

TreeChart can print to a plotter, but a few restrictions are imposed, and you should also bear
in mind a few other points.

The Chart background color is ignored

Box interior colors are ignored

Pen thickness is hardware dependent

Text simulation in print preview is imprecise

See Also
Chart Background Color



 Losing Text When Poster Printing

When TreeChart prints a chart as a Poster, a number of pages are produced which you then 
have to stick together.

The Page margins and Border Margins you specify determine the position of the Border 
relative to the outer edge of these combined pages. For page breaks within the chart, 
TreeChart prints right up to the edge of the printable area.

TreeChart makes no attempt to ensure that boxes don't lie on a page break. To do so would 
be quite difficult: moving a box to avoid a page break might mean that subordinate boxes 
that moved with it were moved onto page breaks. It would also mean that when you 
assembled the separate pages, some boxes would look badly positioned. Boxes can also be 
wider than a page.

Its therefore quite possible that some box text will lie across a page break. Some printers 
perform character level clipping: if this individual character doesn't entirely fit on the page, 
the character isn't printed. Where this happens, characters will be lost at page breaks.

There are two possible techniques to overcome this:

Overlapped Poster Printing

If you choose the Overlapped Poster print style, part of the chart is printed on both sides of a
page break.

Tell the Printer Driver not to perform character-level clipping

Printer Drivers that control printers performing character-level clipping often offer an option 
to disable this operation. The exact mechanism is printer dependent. For a Hewlett Packard 
LaserJet III:

1 From the File menu, choose Print Setup

2 Choose Options

3 Select the Print TrueType as Graphics checkbox

In this particular case, the solution works only if you use TrueType fonts, not printer fonts.



 Connecting Lines Draw Through Boxes

It would appear that some printers (or printer drivers) have problems correctly interpreting 
graphics output. One symptom of this is when drawing a box fails to obscure shadows or 
connecting lines drawn previously: shadows encroach into the box, and unwanted lines are 
printed through the box.

If this happens, please ensure that you have the most recent version of the applicable 
printer driver. TreeChart doesn't do anything particularly clever when printing - if this 
problem occurs, there's an excellent chance that it will also occur for other programs that 
print graphics.

A workaround is available:

1 Start Notepad (or any other text-editing program)

2 Open TREECHRT.INI

This will be in your Windows directory (probably c:\windows). Normally this would be the default directory 
when running Notepad.

3 Under [Preferences], add the line:

PrinterBadClip=1

4 Save TREECHRT.INI

You will need to restart TreeChart for this to take effect.

Note: this workaround applies only to charts printed directly from TreeChart. If you copy a 
picture into another program or save as a picture (.WMF) file, the problem will probably re-
occur if or when you finally perform printing.



 Print Preview Shows Text Badly

There are two unrelated errors that might occur when performing text output during Print 
Preview. Both errors occur because the preview is attempting to accurately simulate the final
printed output.

Incorrect Font during simulation

Occasionally, when choosing a font for use during preview, an inappropriate choice is made. 
Text appears in the correct position, but with characters on top of each other.

Zooming the preview window will correct this problem.

Bad Character Placement

The preview normally positions each character individually, to simulate as closely as 
possible the final output. We have found that a small number of printer drivers cause this to 
fail: characters are so widely spaced that text appears almost as random characters sprayed
around the page.

A workaround is available, to disable trying to position individual characters as they would 
be printed.

1 Start Notepad (or any other text-editing program)

2 Open TREECHRT.INI

This will be in your Windows directory (probably c:\windows). Normally this would be the default directory 
when running Notepad.

3 Under [Preferences], add the line:

PrinterBadPreview=1

4 Save TREECHRT.INI

You will need to restart TreeChart for this to take effect.



 Maximizing the area of paper used when printing
The area of paper available for a chart is determined by the Page Margins and the Border 
Margins. You can make your chart fill the page by:

Using the minimum page margins

and Omitting the Border

See Also
Adding titles and a border
Minimum Page Margins
Omitting the Border
Printing charts



 Minimum Page Margins

Most printers have a small non-printable region at the edges of the page. This constitutes a 
minimum page margin: if you were to choose margins smaller than this, some of your output
would not get printed.

TreeChart handles minimum margins automatically. If the margins you specify in the Page 
Setup dialog box or the Border Margins dialog box would cause any of your chart to 
encroach into the non-printable region, your margins are automatically increased to ensure 
none of your chart or Border are lost.

To have TreeChart automatically place the Border as near to the paper edge as possible 
without losing output:

1 From the Chart menu, choose Page Setup

2 Set all Margins to 0

3 Choose the OK button

If you regularly require charts with minimum page margins, you could save these settings in 
a Template File.

See Also
Adding titles and a border
Printing charts
Speeding up your work with Template Files



 Omitting the Border

The Border frames your chart when you:

Copy a picture to the clipboard

Save the chart in picture-format

Print the chart

If you prefer not to have a border, you must change the Border Layout:

1 From the Chart menu, choose Border Layout

2 Hide all Border text fields

3 In the Line Width list, select '(none)'

4 In the Shadow list, select no shadow

5 Choose the Margins button

6 Set all Margins to 0

7 Choose OK to complete the Border Margins dialog

8 Choose OK to complete the Border Layout dialog

If you regularly require charts with no Border, you could save these settings in a Template 
File.

See Also
Adding titles and a border
Printing charts
Speeding up your work with Template Files



 Exchanging information with other programs

TreeChart can exchange information with other programs either by opening & saving files or 
by copy & paste via the Windows Clipboard.

TreeChart can input text from another program and output text or pictures for use by 
another program.

Text formats supported are those adopted for tabulated information: a box corresponds to a 
line of text, with special characters separating fields. In many cases, you won't need to know
the details of these formats, but further information can be found in Appendix 2 of the User 
Guide.

The picture format used is Windows Metafiles - these can be resized with no loss of picture 
quality.

See Also:
Pasting text from another program into TreeChart
Copying text from TreeChart into another program
Copying pictures from TreeChart into another program
Opening a text-format file
Saving a text-format file
Saving a picture-format file
Working with Metafiles



 Pasting text from another program into TreeChart

Pasting text from another program will create boxes. Each line of text corresponds to a box, 
fields being recognized by examining each line.

Each pasted box initially uses the Default Layout for the level at which it is pasted.

To copy text from Notepad (or similar editor / word processor):

Fields within a line should be separated by TAB characters.

1 In Notepad, select the lines of text you want to copy.
2 In Notepad, from the Edit menu, choose Copy.
3 Switch to the TreeChart chart window you wish to paste into.
4 Move the caret to select the Current Box.
5 From the Edit menu, choose Paste Below, Paste Left or Paste Right, as necessary.

To copy text from a spreadsheet (or a table in a word processor):

This is always simpler than copying text from an editor or word processor, since identifying 
fields is almost foolproof. One new box will be created for each row copied, and each column
corresponds to a field.

1 In the Spreadsheet, select the range of cells you wish to copy.
2 In the Spreadsheet, from the Edit menu, choose Copy.
3 Switch to the TreeChart chart window you wish to paste into.
4 Move the caret to select the Current Box.
5 From the Edit menu, choose Paste Below, Paste Left or Paste Right, as necessary.

Boxes created by pasting text from another program normally contain no hierarchical 
information. All such boxes would therefore be placed at the same level in the hierarchy. 
Appendix 2 of the User Guide describes TreeChart Outline Text, which enables hierarchical 
information, Layout usage and box markers to be defined.

To re-organize a flat hierarchy and have boxes use their correct Default Layout:

1 Cut & Paste the new boxes to form the correct hierarchy
2 Select the boxes using the wrong Layout
3 From the Layout menu, choose Use Default

See Also
Paste Below command
Paste Left command
Paste Right command
Use Default command



 Copying text from TreeChart into another program

TreeChart can copy the text from boxes into other programs. Each box will correspond to a 
line of text, with TAB characters separating the fields.

If you paste into a spreadsheet or word processor table, each box will correspond to a row, 
each field to a column.

To copy box text from TreeChart into another program:

1 Select the boxes whose text you'd like to copy.
If no boxes are selected, the text in the Current Box is copied.

2 From the Edit menu, choose Copy.

3 Switch to the program (and document window) you'd like to paste into, and position 
the insertion point.

4 From the Edit menu, choose Paste.

Copying information in text format is optional.

To enable copy as text format:

1 From the File menu, choose Preferences.
2 Select the Copy Text checkbox.
3 Choose the OK button.

See Also
Copy command
Preferences command



 Copying pictures from TreeChart into another program

When copying a picture, TreeChart draws the Current View and adds the Border. Box 
selections are irrelevant.

Note that Windows imposes a limit on the size of a picture you can copy to the Clipboard (about 11"). If the height 
or width of the chart is greater than this limit, TreeChart scales the drawing. The program you paste the chart into 
may also impose its own limits and scale the chart.

To copy a picture of the Current View from TreeChart into another program

1 From the Edit menu, choose Copy.

2 Switch to the program (and document window) you'd like to paste into, and position 
the insertion point.

3 From the Edit menu, choose Paste.

Copying information as a picture is optional.

To enable copy as metafile format:

1 From the File menu, choose Preferences.
2 Select the Copy Metafile checkbox.
3 Choose the OK button.

See Also
Adding titles and a border
Copy command
Outlining
Preferences command
Working with Metafiles



 Opening a text-format file

TreeChart can create charts from text files. Each line of text forms a box, fields being 
recognized by examining each line.

A Template File can be selected to specify the chart style.

Each box initially uses the Default Layout for the level at which it is created.

To select a Template File:

1 From the File menu, choose Preferences
2 In the Template controls, select the file to serve as the Template
3 Choose the OK button

To create a new chart from a text file:

1 From the File menu, choose Open
2 In the List Files of Type list, choose 'Text Files (*.txt)'
3 In the File Name box, choose the text file you want to open
4 Choose the OK button

Boxes created by opening a text file saved by another program normally contain no 
hierarchical information. All such boxes would therefore be placed at the same level in the 
hierarchy. Appendix 2 of the User Guide describes TreeChart Outline Text, which enables 
hierarchical information, Layout usage and box markers to be defined.

To re-organize a flat hierarchy and have boxes use their correct Default Layout:

1 Cut & Paste the boxes to form the correct hierarchy
2 From the Edit menu, choose Select All
3 From the Layout menu, choose Use Default

See Also
Open command
Preferences command
Select All command
Speeding up your work with Template Files
Use Default command



 Saving a text-format file
TreeChart can save box text as a text file for use by another program. The text associated 
with every box in the chart is saved.

Text format files lose most of the information used internally be TreeChart, so you would 
normally save a copy of the chart as a text format file.

To save a copy of a chart as a text file for use by another program:

1 From the File menu, choose Save As

2 In the Save File as Type list, choose a text format (*.txt)
TreeChart can save in a number of different text formats. If you are unsure which is best for your needs, 
refer to Appendix 2 in the User Guide.

3 In the File Name box, enter a name for the file you want to save

4 Choose the OK button

See Also
Save As command



 Saving a picture-format file

When saving a picture, TreeChart draws the Current View and adds the Border. Box 
selections are irrelevant.

Picture format files lose most of the information used internally be TreeChart, so you would 
normally save a copy of the chart as a picture format file.

To save a picture of a chart for use by another program:

1 From the File menu, choose Save As

2 In the Save File as Type list, choose 'Windows Metafile (*.wmf)'

3 In the File Name box, enter a name for the file you want to save

4 Choose the OK button

See Also
Adding titles and a border
Save As command
Working with Metafiles



 Working with Metafiles

The Metafile graphics format is a standard supported by many Windows programs, and 
allows pictures to be resized without losing picture quality.

To get the best results, the following points should be remembered:

Maintain proportions when resizing pictures

If you resize a picture produced by TreeChart, you should try to maintain the overall 
proportions. If you fail to do this, you'll find that text no longer fits inside boxes.

Changing the picture

Some drawing programs recognize the individual elements that make up a Metafile picture. 
Such programs enable you both to modify existing elements (eg change a line color), or to 
add new elements. Microsoft Draw is an example.

Choose the right program to resize the picture

Drawing programs that recognize individual picture elements can resize all elements, but 
may have trouble resizing text. Other programs (eg word processors) treat the picture as a 
single object, and resizing is much more successful. Where you have a choice, always 
perform overall resizing in a wordprocessor rather than a drawing program.

Font availability

Metafile pictures containing text can be resized because the actual font used is selected 
whenever the picture is subsequently drawn, rather than when TreeChart produced the 
picture.

The fonts used in the picture should be available when the picture is drawn otherwise 
Windows uses the 'nearest' font, which may be unattractive. This tends to be an issue only if
you delete fonts from your computer or if you create a picture on one computer then work 
with it on another.



 TreeChart Commands - Quick Reference

Toolba
r

Menu Shortcuts Description

File menu

New CTRL+N Creates a new chart.

Open CTRL+O Opens an existing chart.

Close CTRL+F4 Closes an opened chart.

Save CTRL+S Saves an opened chart using the same 
file name.

Save As Saves an opened chart to a specified file 
name.

Print CTRL+P Prints the Current View of the active 
chart.

Print Preview Displays the chart on the screen as it 
would appear printed.

Print Setup Selects a printer and printer connection.

Preferences Change TreeChart program preferences.

1,2,3,4 Opens one of four most recently used 
files.

Exit ALT+F4 Exits TreeChart.

Edit menu

Undo CTRL+Z Undo the last insertion or deletion.

Cut CTRL+X Deletes boxes from the chart and moves 
them to the clipboard.

Copy CTRL+C Copies boxes from the chart to the 
clipboard; optionally also copies box text 
and / or a picture.

Paste Below CTRL+V Pastes boxes from the clipboard into the 
chart below the Current Box.

Paste Left CTRL+L Pastes boxes from the clipboard into the 
chart to the left of the Current Box.

Paste Right CTRL+R Pastes boxes from the clipboard into the 



chart to the right of the Current Box.

Insert Above ALT+UP
Drag up from box

Insert a new box above the Current Box.

Insert Below ALT+DOWN
Drag down from 
box

Insert a new box below the Current Box.

Insert Left ALT+LEFT
Drag left from 
box

Insert a new box to the left of the Current 
Box.

Insert Right ALT+RIGHT
Drag right from 
box

Insert a new box to the right of the 
Current Box.

Box Text ENTER
Double click on 
box

Edit the text within the Current Box.

Mark Boxes CTRL+M Marks selected boxes as exceptions to the
Layout rules.

Delete DEL Delete selected boxes.

Swap CTRL+W Swaps the positions of two boxes.

Select All CTRL+A Select all boxes.

Select Level CTRL+H Select all boxes at the same level as the 
Current Box.

Select Subord CTRL+I Select all boxes directly below the Current
Box.

Select Sub-Tree CTRL+T Select Current Box, and all boxes below it.

Select Marked Selects boxes with specific marker 
settings.

Clear Selections CTRL+G De-select all selected boxes.

View menu

Toolbar SHIFT+F2 Show or hide the Toolbar.

Status Bar CTRL+F2 Show or hide the Status Bar.

View All CTRL+Q Show all boxes, by removing Focus & 
expanding collapsed boxes.

Focus CTRL+F Focus on Sub-Tree or the whole chart.

Collapse CTRL+K Collapse selected boxes, making boxes 
below them hidden.



Expand CTRL+E Expand selected boxes, revealing hidden 
boxes.

Expand All CTRL+SHIFT+E Expand all collapsed boxes, revealing 
hidden boxes.

Zoom In + Zoom in, to magnify a portion of the 
chart.

Zoom Out - Zoom out, to see more of the chart.

Zoom Normal = Restore to 100% zoom.

Layout 
menu

Define Layouts CTRL+D Define Layouts.

Text Styles CTRL+Y Change the text style of any field within 
any Layout.

Edit SHIFT+ENTER
SHIFT+double 
click on box

Edit the Layout used by the Current Box.

Size F8 Modify the box size rules of the Layout 
used by the Current Box.

Spacing SHIFT+F8 Modify the spacing rules of the Layout 
used by the Current Box.

Use Default CTRL+U Selected boxes use their Default Layouts.

Defaults Define a default Layout for each level in 
the chart.

Delete Unused Delete unused Layouts.

Chart menu

Define Fields F3 Define box text fields.

Border Fields SHIFT+F3 Define Border text fields.

Border Text F7
Double-click on 
chart 
background

Edit Border text.

Border Layout SHIFT+F7
SHIFT+ double-
click on chart 
background

Modify the Border Layout.



Border Margins CTRL+F7 Modify Border margins.

Match Box 
Sizes

Change the box size-matching rules.

Page Setup Change page margins and print style.

Window 
menu

Cascade Arranges windows in an overlapped 
fashion.

Tile Horizontal Arranges chart windows side by side.

Tile Vertical Arranges chart windows stacked vertically.

Arrange Icons Arranges icons of minimized chart 
windows.

Window 1, 2, ... Goes to specified chart window.

Help menu

Contents CTRL+F1 Offers you an index to topics on which 
you can get Help.

Search for Help 
on

Allows you to select Help by keyword.

How to Use 
Help

Provides general instructions on using 
Help.

Register How to purchase a license to continue 
using TreeChart after the 30-day 
evaluation period.

About Displays TreeChart version number and 
copyright.



 Contents for TreeChart Help
TreeChart is a program you can use to quickly create and print organization charts, or similar hierarchical 
arrangements.

To learn how to use Help, press F1

This is the shareware, or evaluation, version of TreeChart. It is full featured, with no missing 
functions except that it cannot open charts saved by a previous version of the program.

If you feel TreeChart meets your needs and you wish to continue using it beyond the 30-day 
evaluation period, you must purchase a license by registering the program. To see 
registration costs and procedures, from the Help menu choose Register.

Getting Started
Getting Help in TreeChart
The steps involved in preparing charts
Boxes and Layouts
Working in a chart window
Moving around a chart
Inserting Boxes
Selecting Boxes
Using a mouse in a Chart Window
Outlining
Zooming the Chart Display
Marking boxes as exceptions to the rules
Printing charts
Adding titles and a border
Speeding up your work with Template Files
The benefits of registration

Reference
Commands - Quick Reference
Keyboard Shortcuts
Defined Terms

The Toolbar
File menu
Edit menu
View menu
Layout menu
Chart menu
Window menu
Help menu



 Help Menu commands

The Help menu offers the following commands, which offer you assistance with TreeChart: 

Contents Offers you an index to topics on which you can get help.
How to Use Help Provides general instructions on using help.
Search for Help 
On

Allows you to search the online help for particular 
keywords.

Register How to purchase a license to continue using TreeChart 
after the 30-day evaluation period.

About Displays the version number of this application.

See Also
Getting Help in TreeChart



 Register command (Help menu)

TreeChart is not free. It is not public domain. Just like a computer program costing ten times
as much, it is copyrighted by its owners, and you must purchase a license to use it.

Unlike a computer program costing ten times as much, you have the chance to try the 
program before you commit yourself to purchasing the license. This 'try before you buy' 
concept is termed Shareware.

In essence, FineLine Software are granting you a limited-time trial-use license to evaluate 
this program to determine if it meets your needs. If, after 30 days, you wish to continue 
using this program, you must purchase a full license for continued usage. This process is 
termed Registration.

Use this command to register.

See Also
Registration dialog box
The Benefits of registration



 Registration dialog box

If you wish to continue using TreeChart after the 30-day evaluation period, you must 
purchase a license by registering. The Registration dialog informs you of the various ways of 
registering, and the costs involved with each. The dialog can also print an order form if 
needed.

Site licenses and volume discounts are also available - contact FineLine Software for details.

The two choices you must make are:

1. The payment method.
2. Where we're shipping the registration package to.

Your choice in the Payment Method list determines who you should place your order with, 
and the currency that prices are quoted in. You can order direct to FineLine Software from 
anywhere in the world, but customers in the U.S.A. or Australia may find it more convenient 
to order through our local registration agents. Customers who are members of CompuServe 
can register online.

Your choice in the Location list determines postage costs and VAT (sales tax). All 
registration packages are shipped by airmail post from Ireland. VAT is only significant if we 
are shipping within the European Union.

Ordering by phone / E-mail

If you have a credit card, you can phone or E-mail your order. There's no need to complete 
the remaining fields in the dialog, but you'll need to provide this information when placing 
your order.

Ordering by post / fax

Please complete all applicable fields. Choose the Print button to print a pro-forma invoice / 
order form. Please use this printed form, rather than a handwritten order, since it makes it 
much more likely that we'll get all the details correct. If you chose to pay by credit card, 
you'll need to add your credit card details to the printed form.

A customer comment form is also printed. Your feedback helps us to improve the program, 
the documentation and our distribution methods. If you don't wish to make any comments, 
you could just print the first of the two pages.

You cannot print the forms unless you complete the Name, Address and Country fields.

See Also
The Benefits of registration
VAT
Customs Duties
Price Stability



 Value Added Tax

VAT is the European Union term for a sales tax. All sales are subject to Irish VAT, but the rate 
used depends on a number of factors.

The main factor is where we're shipping to, as indicated in the Location list in the 
Registration dialog:

If we ship outside the E.U. (Rest of Europe or Rest of the World), the rate is 0%

If we ship within the Republic of Ireland the rate is 21%

If we ship to another E.U. state (United Kingdom or Rest of European Union), the
rate depends on whether or not you are registered for VAT. If you are registered, the rate is 
0%; if you are not registered, the rate is 21%.

For shipments to E.U. states other than Ireland, VAT will be added at 0% only if you advise us
(when ordering) of your VAT Registration number. If you print an order form, space is 
provided for you to add this.

Note that postage charges reflect actual costs and are charged separately. They are 
therefore not liable to VAT.

A VAT invoice is included in the registration package for all orders shipped within the E.U.

VAT rates and legislation are subject to change.



 Australian Registration Agent

Customers in Australia,    New Zealand or the Pacific Islands may find it convenient to 
register through our local agent:

Budgetware
PO Box 496
Newtown, NSW 2042

voice: (02) 519-4233
fax: (02) 516-4236

Budgetware accept the following credit or charge cards: Bankcard, Mastercard, Visa. 
Budgetware also accept mailed orders with an Aus$ cheque drawn on an Australian bank or 
money orders. These should be made out to "BUDGETWARE".

The above phone numbers are for orders only. Any questions about the status of the 
shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc, must be directed to FineLine Software.

Orders placed through our Australian agent are E-mailed to us the day you order. Your 
registration package will then be dispatched by airmail post within 48 hours. Please allow a 
total of 15 days for delivery.



 Registering direct to FineLine Software

FineLine Software can accept worldwide orders by a number of methods.

FineLine Software
Newtown,
Kinvara,
Co. Galway,
Republic of Ireland

voice/fax: +353 91 37560
CompuServe: 70624,462
E-mail: fineline@iol.ie

FineLine Software accept the following credit cards: Mastercard, Access, Visa and Eurocard.
FineLine Software also accept mailed orders with Irish cheques, Sterling cheques, 
eurocheques and International Postal Money Orders.

Your registration package will be dispatched by airmail post the day after receipt of order. 
Delivery should be 5-10 days later.



 U.S.A. Registration Agent

Customers in the U.S.A. may find it convenient to register through our local agent:

Public (software) Library
PO Box 35705
Houston, TX 77235-5705

toll-free: 1-800-2424-PsL
voice:  713-524-6394
fax:  713-524-6398

When ordering, please quote item #11053.

PsL accept the following credit or charge cards: Mastercard, Visa, Amex and Discover. PsL 
also accept mailed orders with a US$ check drawn on a US bank, payable to "Public 
(software) Library".

The above phone numbers are for orders only. Any questions about the status of the 
shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc, must be directed to FineLine Software.

Orders placed through our U.S. agent are E-mailed to us the day you order. Your registration 
package will then be dispatched directly to you by airmail post within 48 hours. Please allow 
a total of 15 days for delivery.



 Registering via CompuServe

Customers who are members of CompuServe may find it convenient to register online, using
the Shareware Registration database:

Connect to CompuServe

GO SWREG

Follow the prompts

TreeChart's Registration ID is 1927

The cost is charged to your CompuServe account, and will appear in your regular bill.

Orders placed through CompuServe are E-mailed to us the day you order. Your registration 
package will then be dispatched directly to you by airmail post within 48 hours. Please allow 
a total of 15 days for delivery.



 The Benefits of Registration

As well as the legal right to use TreeChart after the 30 day evaluation period, registration 
brings you:

Printed and bound User Guide plus Tutorial

The most recent copy of the program

Lifetime support and a money-back guarantee

'Unregistered version' messages now show that you're another honest shareware 
user

Support if file format changes

Registration remains valid for minor upgrades

Notification of both minor & major upgrades

Automatic (& free) re-registration if a major upgrade is released within six months

Its the right thing to do

Refer to the User Guide for details of our upgrade and support policies.

Changes to the .TCF file format

We aim to continuously improve TreeChart, and in so doing it may be necessary to change 
the way we store your information. This is of no consequence during an evaluation period, 
but becomes significant if you wish to read files saved under an old version of TreeChart into
a newer version. The registered version of TreeChart contains code to automatically detect 
and handle format changes, unregistered versions omit this code, and can only report an 
error if you request an old-format file to be loaded.

TreeChart is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for member products. 
Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI    49442-9427 U.S.A. 
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536. The 
OMB may be contacted by FAX by sending to the ASP FAX number: (+1) (616) 788-2765. In 
communication with the OMB please include a telephone number and/or FAX if available.



See Also
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 Customs Duties

Customers outside the European Union may have to pay customs duties to import our 
product into their country.

We ship by airmail post. This will often be regarded as personal mail, and not dutiable. 
Where customs duties are payable, we minimize them by itemizing the package contents on 
the customs declaration form:

disk: US$1
book: US$8

intellectual property
license:

US$33

We understand that in most cases only the disk will be dutiable. In some cases, the book 
(manual) will be. Almost never are intellectual property licenses dutiable.

Rates and regulations vary between countries: to avoid unexpected costs, you should 
enquire at your local customs office.



 Price Stability

Where possible, we will honor the total cost indicated in the Registration dialog for two years
after the release date.

If you see a message warning you that you are running an old version of TreeChart when the
program starts, then your copy was released at least two years ago, and prices may have 
changed. You should contact us (or our local agents) for current prices, or obtain an up-to-
date copy of the program.

A significant change in VAT rates or legislation is probably the only thing that would cause us
to have to change the total cost within two years of the release date.

See Also
Registration dialog box
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